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Preface 

This document is an introduction to the BioTOF system. It includes:

• An overview of BioTOF operation

• A brief description of the system indicators and controls

• Instructions on acquiring spectra from a known sample

The purpose of this book is to introduce the system and familiarize you with key
concepts. More detailed information on system functions and test sequences is
provided in:

• BioTOF Operator Manual, Volume 1, Theory

• BioTOF Operator Manual, Volume 2, Operation

Three additional manuals in this document set provide information on using the
analytical software included with the BioTOF system.

• DataAnalysis User Manual

• QuantAnalysis User Manual

• Library Editor User Manual

For technical assistance, contact Bruker Daltonics customer service:

In the U.S.: +1 978 663 3660, Ext. 1445

In Germany: +49 (0) 421 2205 430

In Japan: +81 (0) 45 440 0471

Local Service:
Getting Started, Version 1.0 vii



 

Safety Labels

These labels are placed on the instrument to indicate the respective hazard possibility.

Hazard: Note

Refer to the Operator Manual for details on this hazard.

Warning: High Voltage

A dangerous high voltage or shock hazard exists within this area.
Only trained service persons should perform work in this area. 

Warning: High Temperature 

Hot parts and surfaces are present in this area. Allow the part or
surface to cool before performing work in this area. This may require
turning off power to selected components or to the entire instrument.

Warning: Biohazard 

A biohazard may exist within this instrument or specific area. 
Handle this biohazard with appropriate caution and protection.
viii Getting Started, Version 1.0



 1 BioTOF Operation
1 BioTOF Operation

This chapter provides an overview of BioTOF system operation. For a more detailed
description, refer to the BioTOF Operator Manual, Volume I Theory.

The BioTOF system (Figure 1-1) consists of:

• Time-of-flight mass spectrometer

• Electrospray ion (ESI) source

• Computer workstation that controls operation of the system, stores and displays 
spectra, and provides additional analytical software.

In the basic BioTOF configuration, the sample is introduced to the ESI source by means
of a syringe pump (Figure 1-1). The sample can also be delivered to the BioTOF via a
liquid chromatography (LC) system.

 

Figure 1-1 Basic BioTOF System Configuration 

Mass Spectrometer Electrospray 
Ion SourceFlight Tube
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1 BioTOF Operation
1.1 Overview 

Figure 1-2 shows the relationship of the ESI source to the TOF spectrometer and the
orthogonal interface between these two components. The interface contains an
accelerator electrode structure that orthogonally deflects the ions (90o) into the TOF ion
drift region, and also houses the detector that senses the reflected time-dispersed ions.

Figure 1-2 ESI and TOF Operation

1.2 ESI Source

In the ESI spray chamber, a fine spray of charged droplets is generated from the sample
solution by means of a sprayer under the influence of an electric field only or an electric
field with the assistance of a pneumatic nebulizer. When the solvent evaporates from
the droplets, their charge per volume increases resulting in electrostatic (Coulomb)
forces that break up the droplets into ever smaller particles until, in the final stage,
de-solvated sample ions emerge. 

The electric field inside the spray chamber is shaped by potentials applied to three
electrodes: the cylinder, the end-plate and the metal coated entry of the glass capillary
tube.

De-solvation is facilitated by a heated drying gas flowing counter to the stream of
droplets and ions as they are electrostatically attracted towards the capillary tube that is
the inlet orifice of the vacuum system. 

ESI Source

RF Ion Guide

Spray Chamber

Accelerator
Orthogonal Interface:

Drift Region

Detector

Flight Tube

Reflectron (See Figure 1-3)
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 1 BioTOF Operation
Ions enter the vacuum system of the mass spectrometer through the dielectric glass
capillary, stream through a skimmer, and then enter into the RF ion guide, which is
biased at an appropriate offset voltage. Neutral gas molecules that enter with the
sample ions are pumped away in differential pumping stages at successively lower
pressures. 

Ions accumulate in the RF ion guide by means of a trapping voltage applied to the
guide’s exit gate electrode. Then, the voltage on the gate electrode drops for a specified
time and ions drift out of the RF ion guide. Thus, the ions form packets of a spatial
length determined by the pulse width and velocity distribution. At the end of the gate
pulse, the exit electrode potential is raised, starting another cycle of ion accumulation in
the RF ion guide. Determination of the pulse width and repetition rate is explained in the
next section.

1.3 Time-of-Flight Mass Spectrometer 

The packet of ions emerging from the ion guide is collimated by a lens electrode and
travels towards the accelerator with a velocity related to its kinetic energy acquired by
acceleration due to the offset voltage of the ion guide. After the transfer delay, the ion
packet reaches the extraction region of the accelerator. Here a high voltage pulse on the
Repeller changes the trajectory by 90o and pushes the ions into the mass spectrometer
flight tube. The pulse initiates a clock that measures the time-of-flight of the packet from
the accelerator to the Reflectron and ultimately to the ion detector. 

When the high voltage pulse is applied to the Repeller to accelerate the ions down the
flight tube, the voltage also prevents other ions entering the accelerator. When the first
packet of ions has safely entered the field-free drift region of the flight tube, the high
voltage in the accelerator is turned off.

Figure 1-3 Accelerator

Detector

RepellerGrid

Ion Paths

Multideflector
Getting Started, Version 1.0 1-3



1 BioTOF Operation
Since all ions are accelerated by the same Repeller potential in the accelerator, they
reach individual velocities according to their m/z values. All ions of a given m/z ratio take
approximately the same amount of time to travel through the flight tube. The smaller m/z
ions travel faster than those with higher m/z values; the ion packet begins to separate. 

The ions drift through the flight space, pass through the Reflectron lens that provides for
ion beam collimation, and enter the Reflectron at the far end of the tube. A potential
higher than the Repeller accelerator voltage is applied to the far end of the Reflectron;
the ions gradually slow down and eventually reverse direction. 

The reflected ions travel back through the flight tube. In order to prevent a second
deflection in the multideflector, the main steering voltage is now turned off. The ions
penetrate freely through the accelerator and through the Repeller electrode, finally
striking the detector and generating an electrical signal. The arrival time and amplitude
of this signal constitute the raw output data of the BioTOF, and both are recorded by the
data acquisition system. 

1.4 Data Acquisition 

The ion flight time through the tube is proportional to the square root of the ion's
m/z ratio. Thus, during the flight through the mass spectrometer, the ions separate
according to their m/z ratio. Lighter ions arrive at the detector before the heavy ions with
higher m/z values. Conversely, this ratio can be determined from measurement of the
total flight time through the mass spectrometer from the Repeller to the Reflectron and
then to the detector. Measurement of the flight time starts synchronously with the
Repeller high voltage pulse. Recording of the detector signal starts after a digitizing
delay. The digitizer delay determines the lowest m/z value in the recorded spectrum and
shifts the recording window along the mass scale. 

The electrical signal from the detector is converted from analog to digital for each scan.
Multiple scans are aggregated to form a single higher density record. The records are
summed in the digitizer to form a spectrum that is transferred to the workstation.

In MS Only mode, the spectra are further accumulated in a single buffer and the buffer
contents are displayed in the BioTOF window. At the end of the data acquisition, the
contents of the buffer can be saved as a single mass spectrum.

In Chromatography - MS mode, the transferred spectra are stored and displayed
consecutively, and can be saved as time-stamped mass spectra.
1-4 Getting Started, Version 1.0



 1 BioTOF Operation
You specify the width of the recording time window by using one of two methods:

• Selecting a mass range, in which case the BioTOF software automatically
determines digitizer delay in keeping with the other timing parameters.

• Specifying the number scans per record and a sampling speed. The recording
window is given by the time per data point multiplied by the number of points to be
accumulated in each scan. In this case, you must set the appropriate digitizer delay
to assure that the mass range includes ion masses of interest.

The methods used for determining the sampling rates for the various BioTOF Series
models are described in BioTOF Operator Manual, Volume I, Theory.
Getting Started, Version 1.0 1-5
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 2 System Controls
2 System Controls

The principal means for controlling and monitoring the BioTOF system is a Windows
based application configured on the workstation. The software can operate on both
Windows NT and Windows XP platforms. By means of a single multi-pane window, you
can: 

• Start the BioTOF system

• Set the system parameters

• Acquire and display spectra

• Save the data for use with the data processing software included with the system

An array of hardware controls and indicators are located on four panels behind a hinged
door on the front of the BioTOF cabinet. These controls include the On/Off switches for
the mass spectrometer and ESI source components. Many of the controls and
indicators are replicated in the BioTOF software and can be set from the BioTOF
window. An additional panel on the upper right of the BioTOF cabinet displays the status
of the ESI source.

2.1 BioTOF Window

This section gives a brief description of the main window for the BioTOF application.
Refer to Chapter 5 in the BioTOF Operator Manual, Volume II Operation for a detailed
description of the window features including the menus, tool bars and options.

To view the BioTOF window:

1. Turn the workstation on.

2. Do one of the following when the system is initialized:

• Double-click the BioTOF desktop or tool bar icon ( ).

• Choose Start > All Programs > BIOTOF > BioTOF.
Getting Started, Version 1.0 2-1



2 System Controls
The BioTOF window appears (Figure 2-1). Once you have started the application, you
can leave it running, minimizing the window when you are not using the BioTOF system.

Figure 2-1 Layout of the BioTOF Window

The BioTOF window displays information and controls in five different panes:

• The Spectra Display plots the spectra captured by the system. There are a variety
of user-selected formats. For example, the graph in Figure 2-2 shows the intensity
of ion signals from the detector for each m/z value. The two checkboxes in the
bottom left corner of the display control autoscaling for the vertical axis (left) and
horizontal axis (right).

• The pane on the upper left side of the window has system status indicators.

• The pane on the lower left side has command buttons for starting and stopping
spectra acquisitions.

• The four groups immediately to the right of the command buttons include option
button and checkboxes for controlling system operation.

• To the right of these controls are seven tabs for setting system parameters for
acquisition and display of the spectra.

Spectra Display

 Tabs

System Status
Pane

Command
Buttons Pane

System Option Buttons

Parameter Tabs
2-2 Getting Started, Version 1.0



 2 System Controls
Figure 2-2 shows the location of the Autoscaling checkboxes.

Figure 2-2 BioTOF Window and Autoscaling Checkboxes

Autoscaling 
Checkboxes
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2 System Controls
2.2 Front Control Panels

The cabinet door on the front of the BioTOF console provides access to four control
panels (Figure 2-3):

• The Main Control Panel on the top left includes the main power switch and
switches for turning on the vacuum pumps, system electronics, and additional
electrical outlets on the power supply (labeled Computer). These pushbutton
switches light up when they are engaged.

• The Vacuum Gauge Controller on the top right includes an LCD display of the
vacuum pump gauges. Use the numbered membrane buttons on the right to select
the vacuum gauges. Gauges 1 and 3 are used in the basic BioTOF configuration.
Below the selection buttons is an array of buttons for selecting units of measure and
pressure thresholds.

• The Source Control Unit is used to set power for the ESI source and to control
drying and nebulizing gas flows. The unit is powered up when the System
Electronics are turned on from the Main Control Panel. The unit also has its own
power switch in the lower right corner of the unit panel. 

• The Instrument HV Panel includes two 3-position toggles, one for enabling the
supply of high voltage power to the BioTOF electrodes, the other for setting the ion
polarity. When a toggle is centered, the HV or polarity is controlled from the BioTOF
software.

Figure 2-3 BioTOF Control Panels

Vacuum GaugeMain Control

Source Control

Instrument HV

ESI Power

Source HV

Panel

Unit

Switch

Controller

Switch

Panel
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 2 System Controls
2.3 System Status Indicators

Figure 2-4 shows the set of indicators located on the front of the cabinet above the ESI
module. These include a source lens current gauge, and indicators for ion polarity, high
voltage, vacuum, and power.

Figure 2-4 System Status Indicators

Polarity Indicates the ion polarity. Appropriate source and spectrometer 
voltages are set automatically.

High Voltage Shows when the instrument high voltage is on (green) and off (red).

Vacuum Indicates when the flight tube pressure is below threshold.

Power Indicates that system power is on.

Source Lens 
Current

Measures current flow at one of the three spray chamber 
electrodes. The electrode is selected with the Source Control unit. 
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 3 Quick Start
3 Quick Start

This section lists the essential steps required to start the system and acquire spectra
from a known sample.

The sequence description assumes that the BioTOF system has been installed and
calibrated, and is configured with the syringe pump. If the configuration includes an LC
system, the syringe pump is connected via a tee joint between the LC system and the
ESI Source (refer to BioTOF Operator Manual, Volume II, Operation).

The sequence includes these activities:

• Start the System

• Check the Spray Chamber and Sprayer

• Turn the Gases On

• Prepare the Sample

• Check BioTOF Parameters

• Start BioTOF Operation

• Acquire Spectra

• Check Calibration

• Place the System on Standby
Getting Started, Version 1.0 3-1



3 Quick Start
3.1 Start the System

After installation and calibration of the BioTOF system, the system is normally placed in
standby mode rather than being completely powered down, as it can take several hours
to pump down the TOF chamber below the pressure threshold. The instructions in this
section involve the use of the control panels on the front of the BioTOF cabinet to verify
that the system is ready for use.

To start the BioTOF system:

1. Open the front cabinet door to access the BioTOF control panels (Figure 2-3 on
page 2-4).

2. On The Main Switch Panel (Figure 3-1), verify:

• The MAIN pushbutton is illuminated (red)

• The VACUUM PUMPS pushbutton is illuminated (green)

Figure 3-1 Main Switch Panel

3. Press the VACUUM PUMPS button if it is not already lit.

When this button is pressed, it lights up and the pumps start sequentially. However,
the system will not be ready until the pressure in the vacuum system has dropped
below threshold. This may take several hours.

4. Press the ELECTRONICS button to initialize the system electronics including the
vacuum gauge controller (Figure 3-2).

Figure 3-2 Vacuum Gauge Controller

The buttons illuminate 
when pressed to engage 
the switches.

Lights indicate
when the vacuum
levels are below

Press this button to
enable the selected
gauge. 

Number of
 the selected

gauge

Press these buttons

the factory-set 

to select a gauge.

thresholds.
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 3 Quick Start
5. Press the  and  buttons on the vacuum gauge controller to cycle through the
readouts for the gauges used in the BioTOF system:

• Gauge 1 reads the flight tube pressure; this gauge is initially off.

• Gauge 3 reads the pressure in the first pumping stage of the ESI source.

6. Select Gauge 1 and press the ON/OFF button on the gauge controller.

The flight tube pressure must be below 5*10-7 mbar to engage the pressure interlock
of the high voltage supplies.

7. Select Gauge 3.

When the inlet to the vacuum system is open, the pressure should be between 1.5
and 1.9 mbar. When the inlet to the vacuum system is closed, the pressure should
be less than 10-1 mbar.

The indicators labelled 1 through 6 in the upper right corner of the Vacuum Gauge
Controller are lit when the vacuum levels are below the factory-set thresholds. When
indicators 1, 2 and 3 are on, you can safely turn the BioTOF system on. Indicators 4,
5 and 6 are not used.

8. Check the Power Switch in the lower right corner of the Source Control to make
sure that the controller is turned on (Figure 3-3).

The Source Control unit LCD displays the default startup menu.

Figure 3-3 Source Control Unit (top) and Instrument HV Panel

Source Control

Ion Polarity Switch

HV Enable Switch

Power Switch

Source Lens
 Current Reading.
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3 Quick Start
9. Use the arrow button below the LCD display to position the display cursor on End
(Figure 3-4) so that the Source Lens Current gauge on the ESI Source reads the
current on the Endplate Electrode.

Figure 3-4 Setting the Source Lens Current Reading 

10. Set the ion Polarity and Enable switches on the Instrument HV unit to the middle
position.

When the two 3-position switches on the Instrument HV panel (Figure 3-3 on
page 3-3) are in the middle position, the unit is remotely controlled from the BioTOF
window.

11. Check the nitrogen supply.

Select End for
 the Source Lens
 Current Reading.
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 3 Quick Start
3.2 Check the Spray Chamber and Sprayer

The next step is to check the Sprayer Assembly on the front of the ESI Source. The
assembly is attached to the ESI Source with hinges on the right and locked with a latch
on the left. A sample is introduced to the spray chamber via an off-axis spray needle
which is held in position by a bayonet connection. Figure 3-5 shows the sprayer
assembly unlatched and open, and the off-axis sprayer removed from the assembly.

Figure 3-5 Off-axis Sprayer Assembly

To check the Spray Chamber:

1. Release the latch on the left side of the assembly and swing the assembly out so
that the spray shield (Figure 3-5) is visible.

2. Remove the spray shield, remove any plug or rubber seal from the end of the
capillary tube, and re-install the spray shield.

3. Remove the off-axis sprayer assembly from the top of the spray chamber, verify that
the tip of the inner needle protrudes about 0.5 mm from the body of the sprayer, and
reinstall the sprayer.

4. Make sure that the sprayer assembly is connected to the nebulizer gas supply, and
turn the gas valve counterclockwise until it is fully open.

5. Close the spray chamber and secure the latch on the left side to engage the source
voltage interlock.

Spray Shield

Nebulizer

Off-Axis Sprayer

Nebulizer Gas

Gas Valve
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3 Quick Start
3.3 Start the BioTOF Software

To start the BioTOF control software:

1. Turn the workstation on.

2. Do one of the following when the system is initialized:

• Double-click the BioTOF desktop or tool bar icon ( ).

• Choose Start > All Programs > BIOTOF > BioTOF.

3.4 Turn the Gases On

The next step is to set the nebulizer and drying gas controls.

To turn the gases on:

1. Click the Dry Gas and Neb Gas checkboxes in the Gas/Heater Control group
(Figure 3-6), if they are not already on.

2. Click the DG Heat checkbox in the Gas/Heater Control group to turn the heater on.

3. Click the ESI Source tab, and set the Dry Gas Temperature to 200 C.

Figure 3-6 Gas/Heater Group and ESI Source Tab
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 3 Quick Start
4. At the Source Control panel, set the nebulizer gas pressure to approximately 30 psi.

5. Set the drying gas flow so that the ball is at about 1/3 scale (see Figure 3-7).

Figure 3-7 Nebulizer and Drying Gas Controls

3.5 Prepare the Sample

Samples of the following compounds are well suited for electrospray ionization.

• Leucine-Enkephalin (556)

• Reserpine (609)

• Angiotensin I (1046/523)

• Angiotensin II (1296/648)

• Argenine-Glycine-Aspartic Acid (347) 

Leucine-Enkephaline and Reserpine produce singly charged molecular ions (MH+). The
larger peptides generate doubly charged ions (M+2H)2+ and triply charged (M+3H)3+

ions. A typical ESI solvent for these peptides is a 1:1 mixture of methanol-water with
0.1 to 1% acetic acid. 

Drying Gas Flow
Control Knob

Drying Gas
Flow Meter

Nebulizer Gas
Flow Meter

Nebulizer Gas
Control Knob
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3 Quick Start
To prepare a standard ESI sample:

1. Prepare an ESI solvent of 1:1 methanol-water mixture with 0.1% Acetic Acid.

2. Prepare a peptide stock solution in ESI solvent at a concentration of 100 µM, which
is equal to 100 pmole/µL.

3. Dilute the stock solution in the ESI solvent to a ratio of 1/100 to 1/20 to obtain a
sample solution at an analyte concentration of 1 to 5 µM.

To introduce the sample to the system:

1. Fill a 100 to 250 µL syringe with the ESI solvent and position it in the syringe pump
(Figure 3-8). 

2. Set the syringe pump to a flow of 120 µL/h (2 µL/min). 

3. Connect the syringe with the sample inlet of the off-axis sprayer using low volume,
clean tubing and fittings (Figure 3-8). 

Figure 3-8 Connecting the Syringe Pump to the ESI Source

stop

selectRate 120 µL/h

Fill Port Low Volume
Tubing

Syringe

Cole-Parmer Series 74900 Syringe Pump

To ESI

Press and hold these two
buttons for fast forward

run
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 3 Quick Start
3.6 Check BioTOF Parameters 

When the BioTOF control software is started, it automatically loads the Last Good
Method used. If this is the first use of the system since installation, the parameters
saved in Last Good Method are the factory defaults applied in the setup process.

You can acquire data using the parameters from the Last Good Method, or you can
modify the method by changing one or more parameters. You can also load a previously
saved method. In this Quick Start, the Last Good Method is used, but to check the
settings and familiarize yourself with the controls, browse through the parameter tabs.

Note: The parameter values shown in the examples that follow are typical values 
appropriate for the samples used in this Getting Started guide. 

To ensure that the Last Good Method is appropriate: 

1. Check the option buttons in the Ionization and ion Polarity groups to make sure that
the Ionization is set to ESI and that the Polarity is set to Positive (Figure 3-9).

Figure 3-9 Ionization and Polarity Groups
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3 Quick Start
2. Click the ESI Source tab to display the ESI control parameters (Figure 3-10).

Figure 3-10 ESI Source Tab

3. Set the ESI spray chamber voltages in the High Voltage Electrodes group to the
values shown in Figure 3-10.

With ion Polarity set to Positive, the actual spray chamber voltages are negative.
Only the absolute values are displayed.

Note: The software limits the difference between any two of the spray chamber 
voltages to a maximum of 2000 V. You may need to increase the voltages 
sequentially and in steps. 

4. Verify that the seven voltages in the Lens group are in line with the values shown in
Figure 3-10.

On the BioTOF, offset must be 15 V.
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 3 Quick Start
5. Click the Timing Sequence tab to display the timing parameters and verify that the
values are those shown in (Figure 3-11).

Figure 3-11 Timing Sequence Tab

6. Click the Spectrometer tab to display the spectrometer voltages (Figure 3-12), and
verify that the voltage levels are those set during installation.

Note: Changing the parameters in the Spectrometer tab alters the mass 
calibration. The advanced parameters are set during installation and are 
specific to each instrument. Modifying them can adversely affect system 
performance.

Figure 3-12 Spectrometer Tab
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3 Quick Start
7. Click the Acquisition tab and ensure that the spectrum acquisition parameters are
in line with those shown in Figure 3-13.

Figure 3-13 Acquisition Tab

8. Click the Mode tab (Figure 3-14) and set the Instrumentation Mode to MS Only.

Figure 3-14 Mode Tab
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 3 Quick Start
3.7 Start BioTOF Operation

To start BioTOF operation:

1. In the BioTOF window (Figure 3-6 on page 3-6), click the Operation option button in
the Instrument group (Figure 3-15).

Figure 3-15 Instrument Control Group

The instrument goes from Standby to Operation.

• The Enable LED on the Instrument HV unit lights up (Figure 3-16).

• The high voltages ramp up. 

• All ESI source voltages turn on.
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3 Quick Start
You may also be prompted to press the Voltage On button on the Source Control
unit (Figure 3-16). This switch lights up to indicate that the source voltages have
been turned on.

Figure 3-16 Location of the Voltage On Button

Source Control Unit and Instrument HV Panel

2. Set the syringe pump flow rate to 120 µL/h (2 µL/min.) and start the pump.

3. Press and hold the two right buttons on the syringe pump to fast-forward the solution
to the ESI source.

When sample is flowing through the tip of the spray needle assembly, and nebulizer
gas and spray chamber voltages are turned on, the current meter (Figure 3-17) of
the ESI Source gauges indicates the spray current. (If there is no reading, verify that
the meter is set to read the endplate electrode, as described in “Setting the Source
Lens Current Reading” on page 3-4).

4. Return the syringe pump to the 120 µL/h (2 µL/min.) rate when the meter indicates
current.

Figure 3-17 Source Lens Current Reading

Voltage On
Button

LED indicates
when high
voltages are
enabled
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 3 Quick Start
3.8 Acquire Spectra

Controls and indicators for starting and stopping spectrum acquisition are located in the
two panes on the left side of the BioTOF window (Figure 2-1 on page 2-2). You can start
acquisition when the status bar is green and displays Ready (Figure 3-18).

Figure 3-18 Indicators and Controls on the Left Side of the BioTOF Window

To run spectra acquisition:

1. Click the Start button. 

Data acquisition and transfer begin, and the Spectra Display plots the results. The
Spectrum Counter indicates the total number of records accumulated in the buffer.
The Start button changes to a Stop button, enabling you to manually stop acquisition
when a sufficient number of records have been stored in the buffer.

2. Click the two checkboxes in the lower left corner of the Spectra Display (Figure 2-2
on page 2-3) to enable autoscaling for both axes of the display (Figure 3-19). The
BioTOF continues to accumulate records until the buffer contains the number of
records specified in PreSet Spectra.

• If Manual Stop is selected, the buffer is cleared and a new acquisition is started.

• If AutoStop is selected, acquisition stops and the data in the buffer is

You can start
acquisition when

the status bar
is green.

Shows the number
of records stored
in the buffer.
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3 Quick Start
maintained.

Figure 3-19 Spectra Display

3. Set PreSet Spectra to 500 and click AutoStop.

Spectra acquisition automatically stops when 500 spectra have been accumulated.
The Save button becomes active.
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 3 Quick Start
4. Click Save in the control panel.

The BioTOF software opens a dialog box for setting the file options (Figure 3-20).

Figure 3-20 File Save Options Dialog Box

The BioTOF application creates two files, one formatted for the DataAnalysis
application, the other compatible with the XMass program. You can set the
application to use either or both formats by choosing Format > DA  format and/or
Format > Xmass format from the menu bar.
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3 Quick Start
3.9 Check Calibration

As part of the BioTOF installation, the system was calibrated using a table of reference
masses included in the software. The Calibration tab enables you to check the calibra-
tion after acquiring spectra from the known sample. See Chapter 8 in the BioTOF
Operator Manual, Volume II Operation for detailed instructions on checking and adjust-
ing BioTOF calibration.

To check calibration:

1. Click the Calibration tab to display the table of reference masses.

2. Use the pull-down list at the top of the tab to select Peptides.ref to display the
Reference list.

3. Select the first known sample used in acquiring the spectra (Angiotensin-II in
Figure 3-21).

A red vertical line appears in the Spectra Display at the calculated position of the
selected compound on the m/z scale, and the cursor in the Spectra Display changes
to the Max cursor ( ).

Figure 3-21 Calibrating the BioTOF System

Calculated Position

Max Cursor
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 3 Quick Start
4. Drag the cursor immediately to the right of the most intense peak of the reference
compound and click the left mouse button.

The cursor snaps to the peak and the current mass appears in the reference table in
the Calibration tab.

5. Use the same technique to snap the line to each calibration peak.

• A minimum of two peaks is required for linear calibration.

• A minimum of three peaks is required for quadratic calibration.

6. Click the Linear button in the Fit group (Figure 3-21) to display the new calibration
constants.

7. Check for obvious errors, such as negative constants.

Errors can occur if the peaks selected are not the proper compounds or the max
cursor was snapped to the wrong mass.

8. Click the Accept button in the Fit group.

The new values appear in the Constants group to the right, and the Spectrum
Display calibration changes accordingly.

With the system calibration verified using the known sample, you can now proceed to
acquiring spectra from the material of interest. Refer to Chapter 6 in the BioTOF
Operator Manual, Volume II Operation for instructions on flushing the syringe and ESI
unit and introducing the new sample.

3.10 Place the System on Standby

Take the following steps when you have finished with spectra acquisition: 

1. Click Standby in the Instrument group to bring the instrument from operation mode
to standby mode (Figure 3-22).

The ESI source voltages are turned off (the light in the high voltage indicator on the
ESI front panel must be off), the high voltages are turned off, and the Instrument
HV unit is disabled (Enable LED off).

2. Double-check that the ESI voltages and the TOF voltages are off.

Note: For this procedure, the high voltages must be off.
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3 Quick Start
3. Uncheck DG Heat in the Gas/Heater Control Group (Figure 3-21 on page 3-18) to
allow the spray chamber to cool.

Figure 3-22 System Control Settings for Standby

4. Stop the syringe pump.

5. Fill the syringe with ESI solvent or a plain methanol-water mixture and flush both the
transfer line and ESI sprayer several times.

6. Make sure the liquid flows easily through the plumbing.

7. Uncheck Neb Gas in the Gas/Heater Control group. 

8. After the spray chamber has cooled down, wipe clean the spray shield, endplate,
and the face of the inlet capillary. 

9. Close the spray chamber.

10. Return to the BioTOF window and recheck DG Heat.

Note: You should leave the drying gas flow and drying heat on at all times. 
However, if is necessary to conserve your source of drying gas, turn the 
gas off and seal the spray chamber inlet when it has cooled.

You do not need to exit the BioTOF software; simply minimize the application.

Before cleaning the

Click Standby to exit

spray chamber,
 

Operating mode and
shut down the ESI and
TOF voltage sources.

uncheck DG Heat to
 allow the unit to cool.

After cleaning the 

recheck DG Heat.
spray chamber, 
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Preface 

This document provides detailed information on using the BioTOF system. It is consists
of two volumes:

• BioTOF Operator Manual, Volume 1, Theory

• BioTOF Operator Manual, Volume 2, Operation

Three additional manuals in this document set provide information on using the
analytical software included with the BioTOF system.

• DataAnalysis User Manual

• QuantAnalysis User Manual

• Library Editor User Manual

For technical assistance, contact Bruker Daltonics customer service:

In the U.S.: +1 978 663 3660, Ext. 1445

In Germany: +49 (0) 421 2205 430

In Japan: +81 (0) 45 440 0471

Local Service:
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Safety Labels

These labels are placed on the instrument to indicate the respective hazard possibility.

Hazard: Note

Refer to the Operator Manual for details on this hazard.

Warning: High Voltage

A dangerous high voltage or shock hazard exists within this area.
Only trained service persons should perform work in this area. 

Warning: High Temperature 

Hot parts and surfaces are present in this area. Allow the part or
surface to cool before performing work in this area. This may require
turning off power to selected components or to the entire instrument.

Warning: Biohazard 

A biohazard may exist within this instrument or specific area. 
Handle this biohazard with appropriate caution and protection.
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 1 System Components
1 System Components

The Bruker Daltonics atmospheric pressure ionization time-of-flight systems provide
high resolving power, accuracy, and mass range for today’s mass spectrometry needs.
They all have high performance ESI (Electrospray), APCI (atmospheric pressure
chemical ionization) and Nano-Electrospray sample introduction and ionization sources,
highly efficient hexapole ion-guide transfer technology, state of the art orthogonal
acceleration time-of-flight spectrometers and analog-to-digital (ADC) detection systems
for the highest dynamic range and true isotope pattern measurement. 

Like all Bruker Daltonics mass spectrometers, these time-of-flight systems share the
common COMPASS™ data processing and analysis software tools for viewing, printing,
calibration, mass and chromatogram analysis, library search, quantitative analysis,
metabolite search, peptide annotation, and database search.

The series includes:

This manual describes operation of BioTOF systems.

BioTOF™ The highest performance ESI-TOF instrument with unprecedented 
mass resolution and accuracy. The built-in Multipass feature further 
enhances mass resolution. Ideal instrument for accurate mass 
measurement of small molecules. The BioTOF’s versatility and 
mass range make it the best choice for the study of intact proteins, 
polymers, non-covalent protein-protein or protein-ligand complexes, 
or proteomics applications.

BioTOF-Q™ New Quadrupole-TOF (Q-q-TOF) mass spectrometer for sensitive 
and highly accurate MS/MS analysis. It combines state-of-the-art 
quadrupole and TOF technologies and offers fully automated 
precursor detection and ms/ms switching and scan functions. The 
BioTOF-Q is the ideal instrument for peptide analysis and de-novo 
sequencing. Includes Multipass™ TOF for highest mass resolution.

microTOF™ An easy-to-use bench-top package for powerful and exact mass 
measurement. It concentrates the performance of a floor-standing 
instrument in a format that fits on a bench. The microTOF is 
specifically designed for extreme calibration stability, which makes 
it the ideal instrument for accurate mass analysis in all LC-MS 
applications.
Operator Manual, Version 1.0, Volume I: Theory 1-1



1 System Components
The BioTOF system (Figure 1-1) consists of:

Figure 1-1 Basic BioTOF System Configuration

Electrospray ion 
(ESI) source

Generates molecular ions from liquid samples and facilitates ion 
transport from atmospheric pressure into the high vacuum of the 
mass analyzer. The liquid sample is dispersed into a fine spray of 
charged droplets using a sprayer under the action of an electric 
field and pneumatic nebulization. Operation of the source is 
described in Chapter 2 “Source Operation” along with the various 
options for sample introduction.

Time-of-Flight 
(TOF) mass 
spectrometer

Receives ions from the ESI source, redirects them into the flight 
tube using high voltage pulses, and records the flight times. The 
recorded data are delivered to the BioTOF computer workstation 
for display and analysis. Operation of the TOF mass 
spectrometer is described in Chapter 3 “TOF Mass Spectrometer 
Operation”.

Computer 
workstation 

Controls the source and mass spectrometer operation, stores 
and displays mass spectra, and provides additional analytical 
software.

Mass Spectrometer Electrospray 
Ion SourceFlight Tube
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 1 System Components
1.1 Front Control Panels

The cabinet door on the front of the BioTOF console provides access to four control
panels (Figure 1-2):

• The Main Control Panel on the top left includes the main power switch and
switches for turning on the vacuum pumps, system electronics, and additional
electrical outlets on the power supply (labeled Computer). These pushbutton
switches light up when they are engaged.

• The Vacuum Gauge Controller on the top right includes an LCD display of the
vacuum pump gauges and lights indicating when pressures are below threshold.
Function buttons allow you to select gauges, set units of measurement, and specify
threshold settings.

• The Source Control Unit is used to set power for the ESI source and to control
drying and nebulizing gas flows. The unit is powered up when the System
Electronics are turned on from the Main Control Panel. The unit also has its own
power switch in the lower right corner of the unit panel. 

• The Instrument HV Panel includes two 3-position toggles, one for enabling the
supply of high voltage (HV) power to the BioTOF electrodes, the other for setting
the ion polarity. In normal operation, the toggles are centered and HV and polarity
are controlled from the BioTOF software.

Figure 1-2 BioTOF Control Panels

Vacuum GaugeMain Control

Source Control

Instrument HV

ESI Power

Source HV

Panel

Unit

Switch

Controller

Switch

Panel
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1 System Components
1.1.1 System Status Indicators

Figure 1-3 shows the set of indicators located on the front of the cabinet above the ion
source module. These include a source lens current gauge, and indicators for ion
polarity, high voltage, vacuum, and power.

Figure 1-3 System Status Indicators

Polarity Indicates the ion polarity. Appropriate source and spectrometer 
voltages are set automatically.

High Voltage Shows when the instrument high voltage is on (green) and off (red).

Vacuum Indicates when the flight tube pressure is below threshold (green) or 
above threshold (red). High voltage can only be switched on when 
pressure is below threshold.

Power Indicates that system power is on.

Source Lens 
Current

Measures current flow at one of the three spray chamber 
electrodes. The electrode is selected with the Source Control unit. 
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 1 System Components
1.2 Computer Workstation

The principal means for controlling and monitoring the BioTOF system is a
Windows® XP based application configured on the workstation. From a single
multi-pane window, you can start the BioTOF system, set system parameters, acquire
and display spectra, and save the data for use with the DataAnalysis processing
software (included with the system) and other optional software tools.

An array of hardware controls and indicators are configured on the front of the BioTOF
cabinet. These include On/Off switches for the mass spectrometer and ESI source
components. Many of these controls are replicated in the BioTOF software and can be
set from the BioTOF window.

1.3 BioTOF Software

This section gives a brief description of the main window for the BioTOF application.
Refer to Chapter 5 in the BioTOF Operator Manual, Volume II Operation for a detailed
description of the window features including the menus, tool bars and options.

The BioTOF window appears (Figure 1-4) when you start the application. Once you
have started the application, you can leave it running, minimizing the window when you
are not using the BioTOF system.

Figure 1-4 Layout of the BioTOF Window

Spectra Display

Parameter Settings

System Status
Pane

Command
Buttons Pane

System Option
Buttons/Checkboxes

Parameter Tabs
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1 System Components
The BioTOF window displays information and controls in five different panes:

Spectra Display Plots the spectra captured by the system in a variety of 
user-selected formats. The graph in Figure 1-4 on page 1-5 
shows the intensity of ion signals from the detector for each 
mass value (m/z). The two checkboxes in the bottom left 
corner of the display control autoscaling for the vertical axis 
(left) and horizontal axis (right).

System Status Pane Contains the system status indicators.

Command Buttons Pane Contains command buttons for starting and stopping data 
acquisition, and for saving data.

System Option 
Buttons/Checkboxes 

The four vertical groups immediately to the right of the 
command buttons control system operation.

Parameter Settings Parameter settings for acquisition and display of the spectra.
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 2 Source Operation
2 Source Operation

This chapter describes the various means of introducing sample to the ESI source, the
operation of the source using the Electrospray, and the use of the APCI Source.

2.1 Sample Introduction

There are three basic methods of delivering sample to the BioTOF system:

• Syringe pump

• Flow from a liquid chromatography (LC) system

• Off-line Nanospray

2.1.1 Syringe Pump

A syringe pump (Figure 2-1) is included with the instrument system to provide for the
introduction of sample directly to the Electrospray, Nanospray, or APCI ion source.
Tubing from the syringe can be connected directly to the spray or tee’d to the flow from
a LC system. The pump holds syringes from 5 µL to 5 mL. A 100 µL syringe is supplied
with the pump. Function buttons and a small display on the front of the pump enable you
to set flow rate, and stop and start the pump motor.

Figure 2-1 Syringe Pump Included with the BioTOF System
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2 Source Operation
The following are typical syringe pump flow rates for various source configurations:

• Electrospray: 1 to 1,000 µL / (60 µL/h to 60 mL/h)

• On-line Nanospray: 50 to 500 nanoL/min (3 to 30 µL/h)

• APCI: 10 to 1,000 µL / min (600 µL/h to 60 mL/h)

Note: The units of measure on the syringe pump display are volume per hour.

See “Setup for Low Flow Direct Infusion” on page 6-2 for additional information on setup
of the syringe pump.

2.1.2 LC System

Sample can be introduced to the Electrospray, Nanospray or APCI directly from a Liquid
Chromatography (LC) system. 

In LC applications, the ionization is optimized to accept flow rates up to 1 ml/min with the
Electrospray or with the APCI Source. The nebulization process for both of these ion
sources is assisted with nebulizing gas and countercurrent drying gas. 

The LC system can be operated in several modes in conjunction with the BioTOF
system, including standard LC analysis and analysis without LC separation
(flow injection analysis, FIA).

The BioTOF system can be quickly adapted to the different instrumentation modes
using the BioTOF window Parameters tabs described in “Methods” on page 7-1.

2.1.3 Off-Line Introduction

In off-line Nanospray applications, the sample can be introduced directly into the
disposable Nanospray tip itself using a micro-pipet. See “Nanospray” on page 6-10.
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 2 Source Operation
2.2 ESI Source

This section describes operation of the source configured with the Electrospray spray
chamber. Subsequent sections cover use of the Nanospray and the APCI Source.

Figure 2-2 shows ESI Source with the spray chamber opened to show some of the
source components.

Figure 2-2 ESI Source With Open Spray Chamber

In the ESI spray chamber, a fine spray of charged droplets is generated from the sample
solution by means of a sprayer under the influence of an electric field or an electric field
assisted by a pneumatic nebulizer. The electric field inside the spray chamber is shaped
by potentials applied to three electrodes: the cylinder, the end-plate and the metal
coated entry of the glass capillary tube.

When the solvent evaporates from the droplets, the droplets’ charge per volume
increases resulting in electrostatic (Coulomb) forces that break up the droplets into ever
smaller particles until, in the final stage, de-solvated sample ions emerge. The charged
droplets contain analyte, solvent, and a surplus of either positive or negative ions. The
type of ion formed depends on the composition of the sample liquid sprayed. If, for
example, the solution contains the sample in acetic acid with a relative positive potential
on the needle, the predominant positive ions are H3O+ and positively charged molecular
analyte ions of the form [MH]+.

Removable

Endplate
Cylinder

Spray
ChamberSpray Shield
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2 Source Operation
De-solvation of the charged droplets is facilitated by a heated drying gas flowing counter
to the stream of droplets and ions as they are electrostatically attracted towards the
capillary tube that is the inlet orifice of the vacuum system. 

Ions enter the vacuum system of the mass spectrometer through the dielectric glass
capillary, stream through a skimmer, and then enter into the RF ion guide, which is
biased at an appropriate offset voltage. Neutral gas molecules that enter with the
sample ions are pumped away in differential pumping stages at successively lower
pressures. 

Ions accumulate in the RF ion guide by means of a trapping voltage applied to the
guide’s exit gate electrode. Then, the voltage on the gate electrode drops for a specified
time and ions drift out of the RF ion guide. Thus, the ions form packets of a spatial
length determined by the pulse width and ion velocity. At the end of the gate pulse, the
exit electrode potential is raised, starting another cycle of ion accumulation in the RF ion
guide. Determination of the pulse width and repetition rate is explained in the next
section.

Figure 2-3 shows an ESI source configuration.

Figure 2-3 ESI Source Operation
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 2 Source Operation
The following table lists the system components and how they are used for ESI.
 

Table 2-1 ESI Source Operation by Component

Component Function

Off-Axis Sprayer Receives the solution of sample and solvent from a syringe pump or 
liquid chromatograph, passes the solution through a very fine 
needle, and sprays the liquid into the spray chamber.

The needle consists of two concentric tubes, the outer tube carrying 
the nebulizing gas and the inner tube carrying the sample liquid. The 
liquid emerges from the needle into the rapid flow of gas and is 
dispersed into small droplets.

The nebulizing gas pressure is controlled through the software and 
with a control knob on the ESI Source Control front panel.

The sprayer assembly including the spray needle is electrically 
grounded. 

Nebulizer Gas Assists in creating an even and steady dispersion of the sample as it 
is injected into the spray chamber. The nebulizing gas shear forces 
and the strong electrostatic field at the tip of the sprayer to break the 
sample solution into droplets. Since the sample solution is not 
heated when the aerosol is created, ESI ionization does not 
thermally decompose most analytes.

In some low flow rate applications, particularly Nanospray, the 
nebulizer is not used as the electrical fields provide sufficient 
dispersion of the liquid.

Note: The nebulizer gas pressure is set at the Source Control 
panel. If a nebulizing gas is in use, ensure that Neb Gas 
is checked in the Gas/Heater Control Group to the left of 
the tabs.

Sample Liquid

Nebulizing Gas

Nebulizing Gas

Spray Tip

Spray Needle
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2 Source Operation
Cylinder The first of three electrodes that create an electrical field in the spray 
chamber.

Endplate The second of the three spray chamber electrodes. A polished metal 
disk centered around the entrance of the glass capillary. 

High voltage is applied to the endplate, which forms the electrostatic 
gradient in the spray chamber.

Spray Shield Removable metal cap that is part of the Endplate. An opening in the 
center of the spray shield, which is immediately in front of the 
capillary, allows ions to enter the capillary and forces 
counter-current flow of the drying gas.

Capillary 
Entrance

The third of the spray chamber electrodes. The metallized entrance 
to the capillary carries a potential with the following function:

• In positive ion mode, the entrance to the capillary is at -3 kV to
-5 kV relative to the needle and approximately -500 V relative to
the endcap. The electrostatic gradient created by these
voltages supports the production of charged droplets and helps
them to migrate towards the capillary entrance. Once near the
entrance, the analyte ions are pushed through the capillary by
the pressure gradient between the spray chamber (about
1013 mbar, or 760 Torr) and the first pumping stage
(approximately 1 to 2 mbar). The ion Polarity is set with option
buttons in the BioTOF window, just to the left of the Parameter
tabs.

Table 2-1 ESI Source Operation by Component (Continued)

Component Function
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 2 Source Operation
Capillary The capillary is: 

• A sampling orifice that transfers ions from the spray chamber at
atmospheric pressure to the vacuum region of the mass
spectrometer 

• A barrier separating the atmospheric pressure region of the
source from the vacuum region

• Made of a dielectric material that electrically insulates the spray
chamber from the vacuum side.

Drying Gas A heated gas (typically nitrogen or dry air) flowing counter-current to 
the spray of charged droplets that evaporates the solvent, thus 
decreasing the droplet diameter and forcing the charges closer 
together.

While the drying gas assists in the de-solvation process, it does not 
thermally decompose the analytes.

If a drying gas is in use, ensure that Dry Gas is checked in the 
Gas/Heater Control Group to the left of the tabs. The flow rate is set 
on the Source Control panel, and the temperature is set from the 
ESI Source tab in the BioTOF window.

Capillary Exit The first of the vacuum-side voltages.

The metallized exit end of the capillary is typically set in a range from 
80 V to 180 V through the Capillary Exit voltage field on the ESI 
Source tab. As ions exit the capillary, they are electrostatically 
drawn towards the first skimmer which is at a lower voltage. Due to 
the dimensions of the capillary and the pressure gradient, the ions 
emerge from the end of the capillary embedded in a jet flow of 
neutral gas.

High capillary exit voltage can facilitate ion fragmentation.

Table 2-1 ESI Source Operation by Component (Continued)

Component Function
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2 Source Operation
Skimmers Transport and focus the ions into a beam, while neutral gas is 
pumped away in separate, sequential pumping stages.

The voltages established for these ion optical components 
determine the ion transport efficiency. 

The two skimmers have separate voltage settings, which along with 
the Lens voltage setting, are found in the Lens group of the ESI 
Source tab.

RF Ion Guide Six parallel rods that serve as an ion guide and a trap for the 
accumulation of ions. 

As the hexapole RF ion guide transports ions, the neutral gas is 
pumped away (see pumping stage II and III in Figure 2-3 on 
page 2-4).

Two voltages are applied to the hexapole:

• RF Amplitude, typically set at 600 V, peak to peak, with a
frequency of 5 MHz.

• Offset, a constant voltage applied for bias.

The RF Amplitude and Offset are set in the Lens group in the ESI 
Source tab.

Trap Held at a higher voltage than the Offset voltage to prevent ions 
from emerging from the RF ion guide.

The accumulation of ions in the RF ion guide increases the 
efficiency of the instrument.

After a pre-set interval, the Trap voltage drops automatically to 0, 
and the accumulated ions pass through the Lens and Exit plates and 
into the TOF spectrometer.

Lens Concentrates and focuses the analyte ions in the final ESI source 
pumping stage.

Exit The final aperture in the ESI Source. The exit is held at ground 
potential.

Table 2-1 ESI Source Operation by Component (Continued)

Component Function
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 2 Source Operation
2.3 Nanospray

For analyzing small amounts of sample with low concentration, the ESI source can be
configured with the Nanospray assembly in place of the standard BioTOF Electrospray. 

The analyte is delivered to the source via a small inner diameter needle positioned at
the center of the source. Typically, nebulizing gas is not used. Small amount of drying
gas may be used at lower temperatures. The high voltage is applied to the capillary
only.

For Nanospray, the spray chamber with the off-axis Electrospray is removed from the
ESI Source assembly and is replaced by a Nanospray spray chamber (Figure 2-4).

Figure 2-4 Nanospray Spray Chamber Assembly

The assembly includes an XYZ stage mounted on the front of the spray chamber. 

See “Nanospray” on page 6-10 for information on setup and operation.

For on-line Nanospray:

For off-line Nanospray:

The flow rate during operation is less than 200 nL/min 

The flow rate during operation is lower than 20 nL/min 

For on-line Nanospray:

For off-line Nanospray:

The XYZ stage is connected to a NanoLC or the syringe pump. 

The XYZ stage accepts disposable Nanospray tips. 
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2 Source Operation
2.4 E-Z Nanospray

The E-Z Nanospray enables you to set up off-line nanospray without removing the
standard spray chamber assembly. A nanospray needle is filled with 1 to 3 µL of the
analyte solution. The needle is then placed inside the E-Z Nanospray assembly and a
needle shroud.

Figure 2-5 E-Z Nanospray

The assembly is inserted into the front of the ESI spray chamber.

See “E-Z Nanospray” on page 6-16 for information on setup and operation.

2.5 APCI Source Operation

Atmospheric Pressure Chemical Ionization (APCI) is a combined liquid chromatography
and mass spectrometer technique, closely related to Electrospray ionization. 

With the APCI Source, the ESI spray chamber is removed from the front of the source
assembly and replaced with the APCI spray chamber (Figure 2-6). See “Configuring the
APCI Spray Chamber” on page 6-21 for information on changing the spray chambers.

Nanospray Needle

Needle ShroudFunnel

Main Nanospray Assembly Body Collet
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 2 Source Operation
Figure 2-6 Source Configured with APCI Spray Chamber

The APCI technique involves passing LC eluent through a nebulizing needle, thus
creating a fine spray. The spray is then passed through a heated ceramic tube, where
the eluent droplets are fully vaporized. The resulting gas/vapor mixture is then passed
over a corona discharge needle, where the solvent vapor and carrier gas are ionized to
create reagent gas ions. These reagent ions in turn ionize the eluent sample molecules
via a chemical ionization process. 

APCI is an LC gas phase chemical ionization mechanism. APCI requires the analyte in
the gas phase for proper ionization. To bring the mobile phase and analyte into the gas
phase, APCI is typically done at vaporizer temperatures of 400 °C as set on the ESI
Source tab.

The vaporizer temperature must be carefully controlled. Most compounds work best at
higher temperatures while a few compounds work best at lower temperatures. It may be
necessary to evaluate a couple of temperatures to determine the optimal APCI
vaporizer temperature.
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 3 TOF Mass Spectrometer Operation
3 TOF Mass Spectrometer Operation

This chapter describes operation of the Time of Flight (TOF) Mass Spectrometer. 

The major components of the spectrometer (Figure 3-1) are:

• Orthogonal Interface

• Flight Tube (Drift Region and Reflectron)

• Detector

• Digitizer

Figure 3-1 BioTOF Components

The spectrometer directs ions on a round-trip through a flight tube, measures their time
of flight, and provides the digitized mass spectra data to the BioTOF software.

ESI Source

Accelerator
Orthogonal Interface:

Drift Region

Detector

Flight Tube

Reflectron (See Figure 3-2)
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3 TOF Mass Spectrometer Operation
3.1 Orthogonal Interface

Figure 3-2 shows the orthogonal interface with the accelerator, multideflector, and
detector. The interface is located immediately behind the ESI Source. 

Figure 3-2 Orthogonal Interface

The packet of ions emerging from the ion guide in the ESI source is collimated by a lens
electrode and travels into the orthogonal interface with a velocity related to its kinetic
energy acquired by acceleration due to the offset voltage of the ion guide.

Accelerator 

RF Ion Guide in the
ESI Source
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Flight Tube

Repeller

Grid

Multideflector
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 3 TOF Mass Spectrometer Operation
3.1.1 Accelerator

After the transfer delay, the ion packet reaches the extraction region of the accelerator.
Here a high voltage pulse applied to the Repeller (Figure 3-2) changes the trajectory by
90o and pushes the ions into the mass spectrometer flight tube. The pulse coincides
with the start of a digital timer that measures the time-of-flight of the packet from the
accelerator through the Reflectron, and ultimately to the ion detector.

When the high voltage pulse is applied to the Repeller to accelerate the ions down the
flight tube, the voltage also prevents other ions from entering the accelerator. When the
packet of ions has safely entered the field-free drift region of the flight tube, the high
voltage in the accelerator is turned off.

Figure 3-3 shows the Orthogonal Interface (placed on end). Note that the accelerator
includes a series of gold-plated rings separated by resistors that form an homogenous
field. The voltages decrease evenly from the Repeller to the grid.

Figure 3-3 Orthogonal Interface (On End)
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3 TOF Mass Spectrometer Operation
3.1.2 Multideflector

Before the ions enter the flight tube, they pass through the multideflector, which
compensates for the initial orthogonal velocity of the ions and aligns the ion trajectories
along the axis of the flight tube. The assembly consists of a series of gates placed
parallel to the intended ion flight path (Figure 3-4).

Multiple deflectors are used to minimize distortion. Figure 3-4 illustrates the relative time
difference for ions of the same m/z traveling through the narrow multideflector gates
compared with ions traveling through a wider single gate.

Figure 3-4 Minimized Distortion with the Multideflector

Distortion (∆t) without
Multideflector

Distortion (∆t) with
Multideflector
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 3 TOF Mass Spectrometer Operation
The multideflector uses two steering voltages:

Multideflector High and Multideflector Low are set in the Spectrometer tab.

3.2 Flight Tube

The ions pass through the multideflector into the flight tube, which consists of a drift
region and the Reflectron assembly.

3.2.1 Drift Region

Since all ions are accelerated by the same Repeller potential in the accelerator, they
reach individual velocities according to their m/z values. All ions of a given m/z ratio take
approximately the same amount of time to travel through the flight tube. The smaller m/z
ions travel faster than those with higher m/z values; the ion packet begins to separate.
The ion flight time through the tube is proportional to the square root of the ion's
m/z ratio.

Multideflector High A pulsed voltage applied across the gates, steering ions 
as they leave the accelerator.

Multideflector Low A constant voltage applied across the gates to provide steering 
as the ions return to the orthogonal interface and, 
in a multipass application, enter the flight tube again.
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3 TOF Mass Spectrometer Operation
3.2.2 Reflectron

At the end of the drift region, the ions enter the Reflectron assembly at the far end of the
tube. The assembly (Figure 3-5) consists of the Reflectron lens and a series of evenly
spaced gold-plated disks with a hole in the center and separated by resistors, similar to
the rings in the accelerator.

The Reflectron Lens assists in collimating the beam. 

A potential higher than the Repeller accelerator voltage is applied to the far end of the
Reflectron; the ions gradually slow down and eventually reverse direction. 

Figure 3-5 Reflectron and Reflectron Lens

The reflected ions travel back through the flight tube. In order to prevent a second
deflection in the accelerator, the main steering voltage in the tube is now turned off. The
ions penetrate freely through the accelerator and through the Repeller electrode as well,
finally striking the detector.

The Reflectron and Reflectron Lens voltage values are set on the Spectrometer tab.

Reflectron

Reflectron Lens
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 3 TOF Mass Spectrometer Operation
3.3 Detector 

The detector consists of dual microchannel plates and an anode. The dual microchannel
plates are shown in Figure 3-3 on page 3-3.

The plates are configured as a chevron, that is, the microchannels in the first plate are at
an angle to the ion flight path, while the channels in the second plate are at the same
angle but in the opposite direction (Figure 3-6). The microchannels are lined with a
semiconducting layer.

When an ion enters a microchannel, it collides with the channel wall, causing it to
release an electron. The electron then collides with the opposite wall emitting multiple
electrons. As the electrons pass through the channel and the opposite-angle channel in
the next plate, they create an avalanche of electrons.

When the electrons emerge from the microchannel plates, they are collected with a
metal anode generating an electrical pulse in the electronic detection system. 

Figure 3-6 Microchannel Amplification

MICROCHANNEL
PLATE

MICROCHANNEL
PLATE

Anode

e
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positive or negative.

e

e 1. Ion collides with channel wall,
emitting an electron.

2. Electron collides with wall
emitting multiple electrons.

3. Reactions continue, causing an
avalanche of electrons.

4. Electrons bombard anode,
generating an electrical pulse. 
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3 TOF Mass Spectrometer Operation
3.4 Digitizer

Recording of the detector signal starts after a preset digitizer delay. The digitizer delay
determines the lowest m/z value in the recorded spectrum and shifts the recording
window along the mass scale. 

The electrical signal from the detector is converted from analog to digital for each scan.
Multiple scans are aggregated to form a single higher density record. The records are
summed in the digitizer to form a spectrum that is transferred to the workstation.

In MS Only mode, the spectra are further accumulated in a single buffer and the buffer
contents are displayed in the BioTOF window. At the end of the data acquisition, the
contents of the buffer can be saved as a single mass spectrum.

In Chromatography - MS mode, the transferred spectra are stored and displayed
consecutively, and can be saved as time-stamped mass spectra.

The width of the recording time window is specified by either:

• Selecting a mass range, in which case the BioTOF software automatically
determines digitizer delay in keeping with the other timing parameters.

• Specifying the sampling speed and the number of data points per record. The
recording window is given by the time per data point multiplied by the number of
points to be accumulated in each record. In this case, you must set the appropriate
digitizer delay to assure that the mass range includes ion masses of interest.
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 3 TOF Mass Spectrometer Operation
3.5 Time-of-Flight Calculation

The time of flight calculation is derived as follows:

• All ions are accelerated by the same electrical field in the spectrometer. When
entering the drift region, the ions have a kinetic energy equal to the electrical
potential applied to the active section of the accelerator (So in Figure 3-7).

Figure 3-7 Reference Trajectory

• Ekin = Eel = zeU0 where:

 Ekin is kinetic energy

 Eel is electrical energy

 z is the number of charges (charge state)

 e is the elementary charge

 U0 is the electrical potential difference

• Ekin = 1/2m v0
2 where:

 m is mass

 v0 is drift velocity
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3 TOF Mass Spectrometer Operation
This equation establishes the basic relationship between m/z ratio and the ion’s time of
flight, and is used for calibration of the spectrometer. The coefficients c0 and c1 can be
determined experimentally by measuring the time of flight of two ions with different m/z
ratios. See “Calibration” on page 9-1.

• Therefore:

• Time of Flight:

where:   is the effective length of the spectrometer

• TOF is measured in
the experiment

where:  represents the fixed internal electronic
propagation delay of the transistor gates, switches, and
cables, and 

 is the first order coefficient.
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 3 TOF Mass Spectrometer Operation
3.6 Space Focusing

The accelerator and the Reflectron are tuned to compensate for the fact that ions in a
given packet do not travel the same distance in the mass spectrometer. When the ions
arrive in the orthogonal interface from the ESI source, they are at different distances
from the Repeller. Ions closer to the Repeller have a longer round trip in the mass
spectrometer than those further away from the Repeller. To ensure that all ions of a
given m/z arrive at the detector at the same time, the field in the accelerator is shaped
so that ions closer to the Repeller exit the accelerator with higher kinetic energy than
those further away (Figure 3-8). The field in the Reflectron mirrors the accelerator field:
When the ions enter the Reflectron assembly, those with the greater kinetic energy
travel further into the Reflectron before turning around than those with lower kinetic
energy.

Figure 3-8 Space Focusing in Single Pass Mode

Initially a packet of ions (of identical m/z) in the accelerator is dispersed over a small but
finite width in the direction of the flight tube, with some ion being further back (2) and
others (3) being further ahead in the accelerator. When the high voltage pulse is applied
the ions starting further back gain slightly higher kinetic energies than the ions which
started further down. As a result, these ions will have a higher drift velocity in the field
free region of the spectrometer and catch up with the slower ions at a point in the drift
region. For a single stage accelerator this point is at a distance 2So away from the
accelerator.

A similar process is repeated in the Reflectron: The ions with higher kinetic energy and
velocity penetrate deeper into the Reflectron than the ions with lower kinetic energy, and
thus spend more time in the Reflectron. Longitudinal space focusing is achieved if the
total drift length D measured from the first point of passing at 2So is equal to four times
the mean Reflectron penetration depth (D=4Ro).

Space Focusing

2

3

R0S0 2*S0

D = 4Rn
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3 TOF Mass Spectrometer Operation
3.7 Multipass

Multipass is a BioTOF method that enables greater resolution for a specified mass
range.

In multipass, the Repeller potential is held high after the ions enter the flight tube. Thus,
when the ions return from the Reflectron, they are reflected back into the flight tube for
another round trip. After the ions have made the additional round trips in the flight tube,
the Repeller voltage is dropped and the ions pass through the accelerator and to the
detector (Figure 3-9).

Figure 3-9 Ion Path in Multipass Mode

Multipass effectively creates a much longer instrument. Refer to “Multipass” on page 8-7
for information on setting up multipass.
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a label on the lower left side 
near the rear of the 
instrument.

When corresponding with 
Bruker Daltonics Inc. about 
your instrument, be sure to 
include the model and the 
full serial number.

Write the serial number 
of the instrument here for 
reference.

Model: 

Serial Number: 

Part Numbers
In this manual, 
Bruker Daltonics Inc. 
part numbers are generally 
listed in parentheses after 
the name of the part.

A few tools and supplies 
listed have no part numbers 
and are not available from 
Bruker Daltonics Inc. Most 
of these can be obtained 
from laboratory supply 
companies.

Manual part number: A5001

Copyright: Bruker Daltonics Inc.
Manning Park
Billerica, MA 01821 U.S.A.

Internet: www.bruker.daltonics.com

Support: 
FAX: 
Email: 

978-663-3660, Ext. 1445
978-667-5993
support@bdal.com
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Preface 

This document provides detailed information on using the BioTOF system. It is consists
of two volumes:

• BioTOF Operator Manual, Volume 1, Theory

• BioTOF Operator Manual, Volume 2, Operation

Three additional manuals in this document set provide information on using the
analytical software included with the BioTOF system.

• DataAnalysis User Manual

• QuantAnalysis User Manual

• Library Editor User Manual

For technical assistance, contact Bruker Daltonics customer service:

In the U.S.: +1 978 663 3660, Ext. 1445

In Germany: +49 (0) 421 2205 430

In Japan: +81 (0) 45 440 0471

Local Service:
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Safety Labels

These labels are placed on the instrument to indicate the respective hazard possibility.

Hazard: Note

Refer to the Operator Manual for details on this hazard.

Warning: High Voltage

A dangerous high voltage or shock hazard exists within this area.
Only trained service persons should perform work in this area. 

Warning: High Temperature 

Hot parts and surfaces are present in this area. Allow the part or
surface to cool before performing work in this area. This may require
turning off power to selected components or to the entire instrument.

Warning: Biohazard 

A biohazard may exist within this instrument or specific area. 
Handle this biohazard with appropriate caution and protection.
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 4 System Startup
4 System Startup

This chapter describes how to start the BioTOF system.

After installation and calibration, the system is normally placed in standby mode with the
pumps running rather than being completely powered down, as it can take several hours
to pump down the TOF chamber below the pressure threshold. If this system is already
in standby mode, use the instructions in this chapter section to verify that the system is
ready for use.

4.1 Start the System

To start the BioTOF system:

1. Open the front cabinet door to access the BioTOF control panels (Figure 4-1).

Figure 4-1 BioTOF Control Panels

Vacuum GaugeMain Control

Source Control

Instrument HV

ESI Power

Source HV

Panel

Unit

Switch

Controller

Switch

Panel
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4 System Startup
The Main Control panel (Figure 4-2) on the upper left contains four pushbutton
switches which are illuminated when they are engaged.

Figure 4-2 Main Switch Panel

2. Press MAIN pushbutton.

The MAIN is illuminated (red) to indicate the main power is On.

3. Press the VACUUM PUMPS pushbutton to start the vacuum pumps

When this button is pressed, it lights up and the pumps start sequentially. However,
the system will not be ready until the pressure in the vacuum system has dropped
below threshold. This may take several hours.

MAIN The main power supply for the ESI Source and TOF 
Spectrometer.

VACUUM PUMPS Pump controller

ELECTRONICS All system electronics.

COMPUTER Three optional power connections on the bottom left side 
of the console, one of which can be used to supply power 
to the computer workstation.

The buttons illuminate 
when pressed to engage 
the switches.
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 4 System Startup
4. Press the ELECTRONICS button to initialize the system electronics including the
vacuum gauge controller (Figure 4-3).

Figure 4-3 Vacuum Gauge Controller

5. Press the  and  buttons on the vacuum gauge controller to cycle through the
readouts for the gauges used in the BioTOF system:

• Gauge 1 reads the flight tube pressure; this gauge is initially off.

• Gauge 3 reads the pressure in the first pumping stage of the ESI source.

6. Select Gauge 1 and press the ON/OFF button on the gauge controller.

The flight tube pressure must be below 5*10-7 mbar to engage the pressure
interlock of the high voltage supplies.

7. Select Gauge 3.

When the inlet to the vacuum system is open, the pressure should be between 1.5
and 1.9 mbar. When the inlet to the vacuum system is closed, the pressure should
be less than 10-1 mbar.

The indicators labelled 1 through 6 in the upper right corner of the Vacuum Gauge
Controller are lit when the vacuum levels are below the factory-set thresholds. When
indicators 1, 2 and 3 are on, you can safely turn the BioTOF system on. Indicators 4,
5 and 6 are not used.

Refer to the separate Vacuum Gauge Controller documentation for information on
the controller menu for changing units of measure and making other adjustments to
the controller display.

Lights indicate
when the vacuum
levels are below

Press this button to
enable the selected
gauge. 

Number of
 the selected

gauge

Press these buttons

the factory-set 

to select a gauge.

thresholds.
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4 System Startup
8. Check the Power Switch in the lower right corner of the Source Control to make
sure that the controller is turned on (Figure 4-4).

The Source Control unit LCD displays the default startup menu.

Figure 4-4 Source Control Unit (top) and Instrument HV Panel

9. Use the arrow button below the LCD display to position the display cursor on End
(Figure 4-5) so that the Source Lens Current gauge on the ESI Source reads the
current on the Endplate Electrode.

Figure 4-5 Setting the Source Lens Current Reading 

10. Set the ion Polarity and Enable switches on the Instrument HV unit to the middle
position.

When the two 3-position switches on the Instrument HV panel (Figure 4-4) are in the
middle position, the unit is remotely controlled from the BioTOF window.

11. Check the nitrogen supply.

Source Control

Ion Polarity Switch

HV Enable Switch

Power Switch

Source Lens
 Current Reading.

Select End for
 the Source Lens
 Current Reading.
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 4 System Startup
4.2 Check the Spray Chamber and Sprayer

The next step is to check the Sprayer Assembly on the front of the ESI Source. The
assembly is attached to the ESI Source with hinges on the right and locked with a latch
on the left. A sample is introduced to the spray chamber via an off-axis spray needle
which is held in position by a bayonet connection. Figure 4-6 shows the sprayer
assembly unlatched and open, and the off-axis sprayer removed from the assembly.

Figure 4-6 Off-Axis Sprayer Assembly

To check the Spray Chamber:

1. Release the latch on the left side of the assembly and swing the assembly out so
that the spray shield (Figure 4-6) is visible.

2. Remove the spray shield, remove any plug or rubber seal from the end of the
capillary tube, and re-install the spray shield.

3. Remove the off-axis sprayer assembly from the top of the spray chamber, verify that
the tip of the inner needle protrudes about 0.5 mm from the body of the sprayer, and
reinstall the sprayer.

4. Make sure that the sprayer assembly is connected to the nebulizer gas supply, and
turn the gas valve counterclockwise until it is fully open.

5. Close the spray chamber and secure the latch on the left side to engage the source
voltage interlock.

Spray Shield

Nebulizer

Off-Axis Sprayer

Nebulizer Gas

Gas Valve
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4 System Startup
4.3 Start the BioTOF Software

To start the BioTOF control software:

1. Turn the workstation on.

2. Do one of the following when the system is initialized:

• Double-click the BioTOF desktop or tool bar icon ( ).

• Choose Start > All Programs > BIOTOF > BioTOF.

Refer to Chapter 5, BioTOF Window for a complete description of the user interface.

4.4 Turn the Gases On

The next step is to set the nebulizer and drying gas controls.

To turn the gases on:

1. Click the Dry Gas and Neb Gas checkboxes in the Gas/Heater Control group
(Figure 4-7), if they are not already on.

2. Click the DG Heat checkbox in the Gas/Heater Control group to turn the heater on.

3. Click the ESI Source tab, and set the Dry Gas Temperature to 200 C.

Figure 4-7 Gas/Heater Group and ESI Source Tab
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 4 System Startup
4. At the Source Control panel, set the nebulizer gas pressure to approximately 30 psi.

5. Set the drying gas flow so that the ball is at about 1/3 scale (see Figure 4-8).

Figure 4-8 Nebulizer and Drying Gas Controls

6. Review Chapter 5, BioTOF Window for a description of the user interface and
Chapter 6, Introducing Samples for a information on sample introduction to various
ionization methods.

Drying Gas Flow
Control Knob

Drying Gas
Flow Meter

Nebulizer Gas
Flow Meter

Nebulizer Gas
Control Knob
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 5 BioTOF Window
5 BioTOF Window

This chapter gives a detailed description of the BioTOF window including the menus,
tool bars and options.

5.1 Window Layout

To view the BioTOF window:

1. Turn the workstation on.

2. Do one of the following when the system is initialized:

• Double-click ( ).

• Choose Start > All Programs > BIOTOF > BioTOF

The BioTOF window appears (Figure 5-1). Once you have started the application, you
can leave it running, minimizing the window when you are not using the BioTOF system.

Figure 5-1 Layout of the BioTOF Window

Spectra Display
Window

Parameter Tabs
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5 BioTOF Window
The BioTOF window displays information and controls in five different panes:

• The Spectra Display plots the spectra captured by the system. There are a variety
of user-selected formats. For example, the graph in Figure 5-2 shows the intensity
of ion signals from the detector for each m/z value. The two checkboxes in the
bottom left corner of the display control autoscaling for the vertical axis (left) and
horizontal axis (right).

• The pane on the upper left side of the window has system status indicators.

• The pane on the lower left side has command buttons for starting and stopping
spectra acquisition.

• The four groups immediately to the right of the command buttons includes option
button and checkboxes for controlling system operation.

• To the right of these controls are seven tabs for setting system parameters for
acquisition and display of the spectra.

Figure 5-2 shows the location of the Autoscaling checkboxes.

Figure 5-2 BioTOF Window and Autoscaling Checkboxes

Autoscaling
Checkboxes
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 5 BioTOF Window
5.1.1 Status Indicators Group

The four fields in the Status Indicators group (Figure 5-3) provide essential information
about the current status of the BioTOF system:

Figure 5-3 Status Indicators

Table 5-1 Status Indicator Descriptions

Function Description

Instrumentation Displays one of three instrumentation modes as set in the Mode tab:

• MS ONLY for mass spectrometry only

• LC - MS for chromatography and mass spectrometry when the
sample is supplied from an LC system, and you want to display a
chromatogram and the mass spectra. The Spectra display
window is divided into two panes, the top one showing the
spectra and the lower one showing ion chromatograms.

• Injector - MS for time controlled mass spectrometry. FIA-MS
(Flow injection analysis mass spectrometry) has been selected in
the Mode tab to specify a run time. With this mode, you set up the
run in the Chromatographic Setting group by specifying the total
run time in minutes and a wait time for the solvent to clear.
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5 BioTOF Window
5.1.2 Command Buttons Group

Figure 5-4 describes the buttons and fields in the Command Buttons group.

Figure 5-4 Command Buttons

System The system modes are indicated by:

Yellow - STANDBY

Green - READY

Red - Not Ready

Blue - Running

Automation Automatic when the instrument is in Injector - MS mode.

Otherwise, Manual.

Current method Identifies the method in use. Initially the field displays “Last Good 
Method,” the settings in use when the BioTOF application was closed. 
When you load a saved method the Current method displays the 
method file name. See “Methods” on page 7-1.

Table 5-1 Status Indicator Descriptions (Continued)

Function Description
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 5 BioTOF Window
:

Table 5-1 Command Button Descriptions

Function Description

Start/Stop The Start button is enabled when the BioTOF system is in 
Operation mode. Click Start to begin spectra acquisition. The button 
changes to Stop when the system is acquiring data, and changes 
back to Start when acquisition has been stopped either manually or 
automatically.

In MS Only mode, you can stop acquisition and the click Start again 
to continue acquisition.

In Chromatography - MS mode and FIA - MS mode stopping and 
restarting acquisition clears the buffer and Spectra display.

Save Save is active when data acquisition has been stopped. Click Save 
to save spectra from the current session. The spectra are saved in 
the file formats selected from Format menu as described in 
“Format Menu” on page 5-26.

Auto Stop
Manual Stop

When AutoStop is selected, the spectra acquisition stops 
automatically once the system has acquired the number of spectra 
specified in PreSet Spectra. 

When Manual Stop is selected, data acquisition continues until you 
click the Stop button. When the system has collected the number of 
PreSet Spectra, incoming records replace the oldest records in the 
buffer.

Auto Stop and Manual Stop buttons are only active when the 
Instrumentation mode is MS Only.

PreSet Spectra 
Spectrum Counter

Use PreSet Spectra to specify the number of records to be 
accumulated.

The Spectrum Counter shows the actual number of records 
acquired in the current session.

Clear Clears records from the buffer and display, resets the Spectrum 
Counter.
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5 BioTOF Window
5.1.3 System Control Groups

Figure 5-5 describes the option buttons in the four system control groups to the left of
the parameter tabs.

Figure 5-5 System Control Groups
:

Table 5-2 System Control Group Option Descriptions

Function Description

Instrument Sets the instrument mode to Standby HV off, but otherwise ready 
to acquire data) or Operation (ready to start spectra acquisition).

Ionization Identifies the source as electrospray ionization (ESI), nanospray 
(nESI), or atmospheric pressure chemical ionization (APCI).

Polarity Selects positive or negative ion polarity. The various high 
voltages in the system are automatically set to the appropriate 
polarity. The Polarity switch on the Instrument HV panel must be 
in the neutral position to enable control from the BioTOF window.

Gas/Heater Control Toggles dry gas and nebulizer gas flow, and dry gas heating. 
Flow rates are set on the Source Control Unit. Dry gas 
temperature is set with the ESI Source tab in the BioTOF 
window.
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 5 BioTOF Window
5.1.4 Spectra Display Window

When Instrumentation is set to MS Only or FIA - MS, the Spectra Display window
includes a single pane displaying the accumulated records for each m/z value
(Figure 5-6). Units for the horizontal axis can be set to m/z, flight time, or point
(see “Chromatogram Tab” on page 7-6).

Figure 5-6 Spectra Display Window for MS Only and FIA - MS

When Instrumentation is set to Chromatography - MS, the window also includes the
Chromatogram pane that displays ion counts on a time scale (Figure 5-7). In this mode,
the display units in the MS pane can only be m/z.

Figure 5-7 Spectra Display Window in Chromatography - MS Mode
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5 BioTOF Window
5.2 Spectrum Display Pop-up Menu

Several of the Spectrum Display functions in the tool bar are also available from a
pop-up menu in the Spectrum Display Window.

To access the menu:

• Right-click anywhere in the Spectrum Display.

The context menu displays the functions listed in Table 5-3.

Table 5-3 Spectrum Display Window Pop-Up Menu Items

Function Description

Mouse Zoom Rectangle Enables you to define an area and then zoom in to display 
that area by dragging the cursor from one corner of the area 
you want to zoom in on to the opposite corner and then 
releasing the mouse button.

Mouse Shift Changes the cursor to a hand icon ( ) in the Spectra 
display, enabling you to scroll the display by dragging the 
hand vertically or horizontally.

Mouse Zoom Shift

Mouse Max Cursor Changes the cursor to an arrow ( ) and snaps to the next 
highest peak to the left with each left mouse click.
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 5 BioTOF Window
Mouse Data Cursor Changes the cursor to an arrow ( ). The arrow rides along 
the trace as you move the mouse to the right or left.

Freeze Stops updates to the display, while data is still collected in 
the background. Choosing Freeze a second time refreshes 
the display with current data and resumes real time updates.

Background Color Opens a standard Windows dialog box for selecting the 
background for the Spectrum Display (Figure 5-8).

Figure 5-8 Spectrum Display Background Dialog Box

Table 5-3 Spectrum Display Window Pop-Up Menu Items

Function Description
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5 BioTOF Window
Properties Opens the Properties Profile dialog box for setting 
characteristics for the Spectra Display. 

The properties dialog box (Figure 5-9) for the profile display 
sets various display characteristics in the Spectra Display 
window.

Figure 5-9 Properties Profile Display Dialog Box

Cross Display Toggles between the use of crosses and dots to display 
data points. Use the crosses to make actual data point more 
obvious.

Show MS Spectrum Type Replaces the default legend (Profile Spectrum Window). 

Annotate Masses Creates a legend showing the number of points in the mass 
spectrum.

Table 5-3 Spectrum Display Window Pop-Up Menu Items

Function Description
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 5 BioTOF Window
Show m_Time Creates a legend showing the time of the last spectra 
acquisition.

Show m_TIC Creates a legend showing the total ion count.

Show WinTips Enables tooltips, in which the value of data is displayed 
when you place the cursor over a data point in the display.

Title Mode Toggles the display of a title bar above the Spetra Display 
window.

Separate Legend Creates a separate bar above the Spectra display window 
for legends that would otherwise appear in the upper left 
corner of the window.

Digits Sets the number of digits to the right of the description in 
the display of data points in the Spectra Display window.

Split Mode Creates a separate legend above the MS pane rather than 
displaying the legend data in the top left corner of the 
MS pane.

Data Lists the possible colors for the traces and data points.

Axes Lists the possible colors for the axes.

Background Color Opens a Windows Color dialog box for selecting the 
background color for both panes in the Spectra Display 
window.

Show Peak Width Displays the width of peaks in Dalton.

Note: Some functions are not available in earlier versions of the 
BioTOF software.

Table 5-3 Spectrum Display Window Pop-Up Menu Items

Function Description
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5 BioTOF Window
5.2.1 Parameter Tabs

The seven tabs below the Spectra Display window set the parameters for the collection
method:

For more information, see “Methods” on page 7-1.

5.3 Menus and Tool Bar

This section lists the BioTOF functions available from the menu bar and tool bar
(Figure 5-10).

Figure 5-10 BioTOF Menu Bar and Tool Bar

Tab Description

Mode Sets the instrument mode, display units, and mass range.

Chromatogram Defines a range of ion counts to mark the 
chromatogram display when Chromatography - MS mode is 
selected.

Calibration Calibrates the BioTOF system using reference tables.

ESI Source Specifies gas temperatures and voltage levels for the ESI 
Source.

Spectrometer Sets voltages applied to various components in the mass 
spectrometer.

Timing Sequence Sets advanced timing parameters for the mass 
spectrometer.

Acquisition Sets sampling rate, spectrum size and other data 
acquisition parameters.
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 5 BioTOF Window
5.4 File and Edit Menus

Exit is the only active item in the File menu; the Edit menu is not used in he BioTOF
application.

To close the BioTOF window:

• Choose File > Exit from the menu bar, or click ( ) in the upper right corner of the
window.

5.5 View Menu

5.5.1 Tool Bar

• Choose View > Tool Bar to toggle the display of the BioTOF tool bar (Figure 5-10)
on and off.

The tool bar includes functions for controlling the Spectra Display properties and for
quick access to functions in the Method and Tools menu. The icons are described in
Table 5-4.

Table 5-4 BioTOF Tool Bar Icons

Icon Function Description

Select Method Displays a Windows Open dialog box for loading a 
previously saved method. See “Load Method” on 
page 5-18.

Start Starts spectra acquisition.

Stop Stops spectra acquisition.

Get Active Values Retrieves parameter values from the BioTOF drivers so 
that tab displays reflect values actually being sent to the 
system controllers.
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5 BioTOF Window
Print Opens a Print dialog box for selecting a printer, setting 
print properties, and printing the current spectra. See 
“Load Method” on page 5-18.

Autoscale X Axis Automatically scales the horizontal axis in the Spectra 
Display to show the full range of values. Equivalent to 
checking the left checkbox in the bottom left corner of the 
Spectra Display.

Autoscale Y Axis Automatically scales the vertical axis in the Spectra 
Display to show the full range of values. Scale increases 
as additional records are accumulated. Equivalent to 
checking the right checkbox in the bottom left corner of 
the Spectra Display.

Autoscale Both Axes Automatically scales both axes of the Spectra Display. 
Equivalent to checking both checkboxes in the bottom 
left corner of the Spectra Display.

Increase X Range Increases the scale of the horizontal axis without 
changing the vertical axis.

Decrease X Range Decreases the scale of the horizontal axis without 
changing the vertical axis.

Increase Y Range Increases the scale of the vertical axis without changing 
the horizontal axis.

Decrease Y Range Decreases the scale of the vertical axis without changing 
the horizontal axis.

Scroll Left Scrolls the Spectra Display to the left.

Scroll Right Scrolls the Spectra Display to the right

Scroll Up Scrolls the Spectra Display up.

Table 5-4 BioTOF Tool Bar Icons (Continued)

Icon Function Description
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 5 BioTOF Window
Scroll Down Scrolls the Spectra Display down.

Zoom Places the Spectra Display in Zoom mode. The display 
zooms in on the area you mark with the cursor. To mark 
the area, drag the mouse cursor from the top left corner 
of the area to the bottom right corner. As you drag the 
cursor, a dotted line defines a rectangular area of 
interest. When you release the cursor, the area is 
enlarged to fill the Spectra Display.

Zoom mode can also be invoked by right-clicking 
anywhere in the Spectra Display and choosing Zoom 
Rectangle from the pop-up menu.

Shift Changes the cursor to a hand icon ( ) in the Spectra 
display, enabling you to scroll the display by dragging the 
hand vertically or horizontally.

Max Cursor Changes the cursor to an arrow ( ) and snaps to the 
next highest peak to the left with each left mouse click.

Perpendicular Cursor Changes the cursor to an arrow ( ). The arrow rides 
along the trace as you move the mouse to the right or 
left.

Free Cursor Changes the cursor to the default cursor used by the 
computer. Free mode allows you to place the cursor 
anywhere in the Spectra Display. The cursor may leave 
the screen when you zoom in.

Display Dots Toggles the trace line in the Spectra Display on and off. 
When the line is off, the dots representing data points are 
visible. Use Displays Dots to distinguish between a peak 
(consisting of multiple data points) and a spike (a single 
point that could be the result of system noise or another 
anomaly).

Table 5-4 BioTOF Tool Bar Icons (Continued)

Icon Function Description
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Display Crosses Toggles between the use of crosses and dots to display 
data points. Use the crosses to make actual data points 
more obvious.

About TOF Control Displays version and copyright information for the 
BioTOF Control software.

Context Sensitive Help Launches BioTOF Help

Default Size - 
Automatic Mode

Hides the Parameter tabs so that more of the Spectra 
Display is visible. Drag the bottom edge of the Spectra 
Display window up to bring the tabs into view.

Default Size - 
Advanced Mode

Includes the Parameter tabs in the default BioTOF 
display. Drag the bottom edge of the Spectra Display 
window down to hide the tabs.

Start HyStar Launches the HyStar Software for Chromatography and 
Hyphenated Experiments application, placing the 
BioTOF system under the control of the HyStar 
application until you exit that application.

Table 5-4 BioTOF Tool Bar Icons (Continued)

Icon Function Description
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5.5.2 Status Bar

The Status Bar displays the following information:

• A short description of the currently selected function or field.

• Any Spectra Display options (such as Max Cursor) that have been selected from
the tool bar.

• The X and Y coordinates of the cursor in the Spectra Display window.

To toggle the display of the status bar at the bottom of the window:

• Choose View > Status Bar.

5.5.3 Resize Dialog

The two options available from the Resize Dialog determine the initial size of the
Spectra Display window:

• Choose View > Resize Dialog > Automatic Mode to hide the Parameter tabs so
that more of the Spectra Display is visible. Drag the bottom edge of the Spectra
Display window up to bring the tabs into view.

• Choose View > Resize Dialog > Advanced Mode to include the Parameter tabs in
the default BioTOF display. Drag the bottom edge of the Spectra Display window
down to hide the tabs.
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5.6 Method Menu

When the BioTOF window is opened, the application loads Last Good Method, that is,
the system settings and parameters that were in use when the system was closed. The
Method menu allows you to save the current method to a file and load previously saved
methods.

5.6.1 Load Method

To load a previously saved method:

1. Choose Method > Load Method from the menu bar, or click ( ) in the tool bar.

An Open dialog box displays the methods that have been saved in ..\Data\Methods
folder (Figure 5-11). The files in the folder are filtered to include only those with the
extension *.tofpar.

Figure 5-11 Open Dialog Box for Loading a Method

2. If the method is stored in another location, use the dialog box tools to browse to the
other folder.
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3. Select the method and click Open.

The BioTOF system displays a progress gauge as it loads the method (Figure 5-12).
It may take several minutes for the data to be loaded. When it is finished, the
method file name is shown in the Current Method box on the left side of the BioTOF
window.

Figure 5-12 Progress Gauge as a Method is Being Loaded

5.6.2 Save Method

Use the Save As function to create a new method or to update a previously saved
method. This menu function does not save data. Use the Save button in the Command
Buttons pane on the left side of the window to store data for analysis.

To save the current method for later use:

1. Choose Method > Save As to open a Save As dialog box (Figure 5-13).

The dialog box displays the methods that have been saved in ..\Data\Methods
folder; the files in the folder are filtered to include only those with the extension
*.tofpar. You can change the path, but you must use the *.tofpar extension.
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Figure 5-13 Save As Dialog Box for Saving a Method

2. Select an existing method in the dialog box to update the file with the current
parameters, or enter an unused name to create a new method.

3. Click Save.

If you save to an existing name, a dialog box prompts you to confirm the action.

• Click Yes to overwrite the previous file or No to cancel the action and select a
new name.

5.7 Tools Menu

The Tools menu includes diagnostic functions and a link to the HyStar application, if it is
installed on the BioTOF workstation.

5.7.1 Get Actual Values (F5)

Note: This feature is available with Version 3.0 and greater.

The values displayed in the Parameter tabs may differ from the values being sent by the
controllers to the BioTOF hardware. For example, the tabs may be displaying ESI
Source settings from a just loaded methods file, but the ESI Source controller has not
yet apply those settings.

To display the controller values in the BioTOF window:

• Choose Tools > Get Actual Values from the menu bar or click  in the tool bar.

5.7.2 Open HyStar NT

The Tools > Open HyStar NT menu selection is active when the HyStar Software for 
Chromatography and Hyphenated Experiments application is installed on the BioTOF 
system host, enabling you to launch the HyStar application and run hyphenated 
experiments that include BioTOF with the current loaded method.
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5.7.3 Diagnostics

Selections in the Tool > Diagnostic menu enable you to compare actual system values
with the indicators in the BioTOF window:

To display the parameters set in the ESI Source controller: 

1. Choose Tools > Diagnostics > Ionization Source from the menu bar to display the
Electrospray Ionization Source Setting dialog box (Figure 5-14).

Figure 5-14 Electrospray Ionization Source Setting Dialog Box

2. Compare the display with the settings in the ESI Source tab.

3. Click Get to refresh the display if the dialog box has been opened.

4. Click OK to close the dialog box.
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5.7.3.1 Spectrometer

The Parameter Settings - Spectrometer dialog box (Figure 5-15) displays the ion
polarity, voltage levels and timing parameters in the mass spectrometer as set in the
controller, enabling you to compare actual system values with information in the
Spectrometer and Timing Sequence tabs in the BiotOF window.

1. Choose Tools > Diagnostics > Spectrometer from the menu bar to display the
Parameter Settings - Spectrometer dialog box.

2. Click Get to refresh the display if the dialog box has been opened.

3. Click OK to close the dialog box.

Figure 5-15 Parameter Settings - Spectrometer Dialog Box
5-22 Operator Manual, Version 1.0, Volume II: Operation



 5 BioTOF Window
External Switches

The BioTOF system supports two external devices. The External Switches group
includes two data fields that show the current value of the inputs and two buttons for
triggering outputs:

The external switches are configured and enabled from the Mode tab. See “Mode Tab”
on page 7-3.

External In 1 Input from the external device switches the BioTOF control software to 
transition from Standby to Operation. This is equivalent to clicking the 
Operation option in the Instrument group.

External In 2 Input from the external starts spectra acquisition. This is equivalent to 
clicking the Start button.

External Out 1 Output to the Ready switch in the external device (however defined in 
the other system).

External Out 2 Output to the Ready switch in the external device (however defined in 
the other system).
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5.7.3.2 Digitizer

To compare actual values in the digitizer with settings in the Acquisition tab in the
BioTOF window:

1. Choose Tools > Diagnostics > Digitizer from the menu bar to display the
Parameter Settings - Digitizer dialog box (Figure 5-16).

Figure 5-16 Parameter Settings - Digitizer Dialog Box

2. Make changes by typing directly in the value fields and clicking the option
checkboxes.

3. Click OK or  in the upper right corner to close the dialog box.

5.7.4 Show Servers

The Show Servers selection in the Tools menu provides access to the messages
generated by the various servers that make up the BioTOF application:

• Bruker TADS Server - IC1

• Bruker ESI Controller - ESI Con1

• Bruker TREC Server - IC1

To view server message traffic:

1. Choose Tools > Diagnostics > Show Servers in the menu bar so that the option is
checked.

The Windows task bar displays a button for each server.
5-24 Operator Manual, Version 1.0, Volume II: Operation



 5 BioTOF Window
2. Click a server button to open a separate window to display the message traffic.

Figure 5-17 is an example of message traffic for the ESI Controller (ESIcon1).

3. Click  in the upper right corner of the window to minimize the display to the
task bar.

Note: Do not use  to close the window as this action stops the server 
program.

4. Choose Tools > Diagnostics > Show Servers in the menu bar a second time to
uncheck the option and clear the server buttons from the task bar.

 

Figure 5-17 ESI Server Window
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5.8 Format Menu

By default, the BioTOF application saves spectra to two file formats for use with the data
processing applications: 

• DataAnaylsis

• XMass

To specify formats for saving data:

1. Choose Format from the menu bar.

2. Click either or both of the formats listed.

A format is selected when a checkmark appears to the left of the menu option. To
deselect an option, click a checkmarked menu option and the checkmark is
removed.

5.9 Help Menu

The Help menu has two selections:

• Help Topics provides information on the BioTOF application using a the Windows
Help system.

• About TOF Control displays the version and copyright information.
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6 Introducing Samples

This chapter describes how to set up sample inlets for Electrospray ionization using the
syringe pump and/or a liquid chromatography (LC) system. The chapter then describes
the use of the Nanospray and Atmospheric Pressure Chemical Ionization (APCI)
options.

6.1 Sample Delivery to Electrospray

Many analytical methods can be accomplished by directly pumping the analyte in
solution to the Electrospray using the supplied syringe pump. Often the sample has
already undergone some separation or purification process.

Direct infusion can be accomplished at a low flow rate using the syringe pump only and
at higher flow rates using the LC system.

• In low-flow mode, the outlet of the syringe needle is coupled through the necessary
fittings to the union on the inlet of the Electrospray. Direct low flow rate is capable of
higher sensitivity as there is no dilution. Low flow is often associated with small
sample volumes.

• In the high-flow configuration the actual delivered flow rate is determined by the LC
pump. The flow from the syringe pump is tee’d into the flow from the LC by means
of a low dead volume fitting inserted into the flow path directly before the
Electrospray union. The addition of solvent from the LC system can reduce certain
buffer effects. The increased flow rate also makes it possible to optimally use
infusion for APCI work where higher flow rates are optimum. If the target application
for a particular analysis is found in LC analysis, then tee’ing into this flow with a
representative standard can be useful during method development while optimizing
instrument conditions.

One of the most common uses of direct infusion is to provide continuous introduction of
sample while optimizing the mass spectrometer for a particular analysis. The most
general case is the direct infusion of a standard tuning solution. These solutions can be
introduced either in the low flow configuration or in conjunction with the LC pump,
depending on whether the target analysis will occur with the LC.
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6.1.1 Syringe Pump

The syringe pump (Figure 6-1) can be used to drive glass syringes from 5 µL to 5 mL.
The BioTOF system includes a 100 µL syringe suitable for most applications.

Figure 6-1 Syringe Pump

6.1.2 Setup for Low Flow Direct Infusion 

The simplest configuration is a direct connection of the syringe pump to the
Electrospray. The flow is started by the keypad on the front of the syringe pump.

To set up the direct infusion to the Electrospray:

1. Fill the syringe with the ESI solvent and sample liquid, avoiding any bubbles.

2. Connect the syringe with the sample inlet of the off-axis sprayer using low volume,
clean tubing and fittings (Figure 6-2).

3. Position the syringe in the pump. 

Lift the syringe clamp on the pump, place the syringe barrel in the holder as shown
in Figure 6-1, and place the clamp on the syringe.

Syringe Clamp

Release
Button

Advance
Plate
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4. Press the release button on the front of the drive plate and advance the plate so that
it rests against the syringe plunger (Figure 6-2).

Figure 6-2 Syringe Pump Controls

5. Turn the syringe pump on using the rocker switch on back of the pump just above
the power cord connection.

6. Press Select on the pump keypad to access a menu on the small display to the left
of the select button.

The displays show three items at a time. To select an item:

• Use the arrow keys to scroll through the menu and highlight the item and then
press Select.

7. Select Table to display a list of syringe manufacturers, highlight the syringe
manufacturer, and press Select.

8. Choose the Size/Dia table, select the syringe, and press Select.

9. Choose the Rate from the menu, and use the arrow keys to set the syringe pump to
a flow rate, and press Select.

Note that the rate is specified in volume per hour, not per minute.

stop

selectRate 120 µL/h

Fill Port Low Volume
Tubing

Syringe

Cole-Parmer Series 74900 Syringe Pump

To ESI

Press and hold these two
buttons for fast forward

run

Release Button Advance Plate Syringe Clamp
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6.1.3 Adjusting the Electrospray Needle

The Electrospray needle consists of two concentric cylinders, the outer one supplying
the nebulizing gas and the inner one carrying the sample liquid. The inner needle should
protrude from the outer barrel by about 0.5mm. To optimize spray performance for some
low flow rate application, it may be necessary to adjust the needle outward.

The Electrospray needle is mounted off-axis in the top of the spray chamber. The
Electrospray needle is held in position by a bayonet connection.

To check the Electrospray Needle:

1. Remove the off-axis sprayer assembly from the top of the spray chamber.

2. Verify that the tip of the inner needle protrudes about 0.5 mm from the body of the
sprayer.

To adjust the needle position:

1. Loosen the lock nut shown in Figure 6-3.

Figure 6-3 Adjusting the Electrospray Needle

2. Hold the bayonet connection with one hand and turn the needle assembly clockwise
to extend the inner needle outward, or counterclockwise to draw the needle back
into the assembly.

3. Tighten the lock nut and reinstall the assembly in the spray chamber.

Lock Nut

Bayonet
Connection

Turn the needle assembly clockwise to the
extend needle tip beyond the outer cylinder.
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6.1.4 Starting the Syringe Pump

To operate the syringe pump:

1. Press Run to start the pump.

2. Press the right arrow key and Run simultaneously to push the liquid to Electrospray.

This is called Fast Forward mode.

3. Release the buttons to stop the pump.

4. Press Run to operate at the specified rate.

After the flow has reached the source end of the nebulizer, some additional optimization
may be required for low flow rates, such as adjusting the amount of nebulizing gas,
drying gas and, in some cases, a slight re-adjustment of the extension of the nebulizer
needle.

To adjust the spray needle on-line:

1. Loosen the lock nut.

2. Rotate the body of the needle clockwise or counterclockwise.

3. Make quarter turns and observe the result with the Source Lens Current in the
System Status indicators on the ESI Source.

4. When the spray is optimized, tighten the lock nut.
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6.1.5 Flushing the Syringe Pump 

Unlike FIA or liquid chromatography, direct infusion has no solvent flow between
samples to flush the sample path. The entire sample path must be flushed with solvent
before and after each sample infusion. If you have enough sample, flush the entire
system with the new sample before acquiring data.

To flush the entire system: 

1. Fill a syringe with solvent and connect it to the sample tubing.

2. Ensure that the nebulizing and drying gases are on.

3. Inject one full syringe of solvent or sample through the sample path.

Note: Push the liquid through slowly.

4. Check all fittings for leaks. 

Tighten fittings if necessary. 

5. Verify that the spray is straight with respect to the needle.

If the spray is not straight, the needle may be bent or partially clogged.
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6.2 Liquid Chromatography (LC) 

The most common form of sample introduction is accomplished by means of an LC
system. There are different configurations that are possible with LC which can include
use of a pump, automatic sampler, and column. Frequently, the system includes an
inline UV detector for dual detection. Certain analyses may not necessarily require the
use of an analytical column and are referred to as flow injection analysis (FIA).

The Electrospray system accepts solvent flows up to 1 mL/min. It is compatible
with both standard LC columns (2.1 mm to 4.6 mm inner diameter) and microcolumns
(320 µm to 1.0 mm inner diameter). The APCI Source accommodates flow rates up to 2
mL/min.

Reversed-Phase LC

Proteins and peptides exist as amphoteric species which have charged (or
chargeable) sites available on relatively hydrophobic molecules. Both charged sites
and hydrophobic characteristics are present.

Proteins and peptides are usually separated using mobile phase modifiers such as
trifluoracetic acid (TFA). TFA inhibits positive ion formation in Electrospray. This
problem can be overcome through the post-column addition of high concentrations
of volatile weak organic acids, such as formic or acetic acids.

Normal-Phase LC 

Normal-phase LC can be used with Electrospray. Solvents used are typically
non-aqueous and non-polar. The compounds separated are relatively nonpolar. To
overcome this, compounds can be protonated (M+H)  if a proton donor is present in
the solution. Alternatively, alkali metal cation adducts can be formed by the addition
of sodium acetate, potassium acetate, or other metal acetate salts, as well as some
organic compounds. 
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6.2.1 Operating With Liquid Chromatography 

A liquid chromatograph (LC) can serve several functions in an Electrospray interface.

As a Pump

In this mode of operation, only the LC pump is used. The sample is injected
manually into a sample loop on the multiport valve. The valve is switched manually
to transport the sample into the Electrospray interface. The pump flow can be set
manually on the LC keypad or through the system software.

As a Pump and Sample Inlet

This mode is essentially flow injection analysis but the LC performs all of the
functions performed by the multiport valve in manual flow injection. The LC serves
as a pump and injector. The LC column, if one is present, is switched out of the flow
path and no separation takes place. The injections can be manual or automated.
This mode of operation can be controlled manually on the LC keypad or through the
system software.

As a Liquid Chromatograph

In this mode, the LC operates as a normal liquid chromatograph. A column is
installed and sample separation takes place. Setting up an LC for operation with the
Electrospray (or APCI) is mostly a matter of determining the correct solution
chemistry. The solvents and buffers must provide good chromatography and
enhance, or at least not inhibit, ion formation. Buffers can be added before or after
separation (pre- or post-column) depending on the chemistry involved. The correct
choices are highly sample dependent. The LC is typically controlled through the
system software.

As an LC With a Second Detector

If a second detector is used with Electrospray interface, it must be upstream of the
mass spectrometer because the sample is otherwise destroyed by the mass
spectrometer.
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Two configurations are possible:

Serial path

The sample flows first through a flow cell in a non-destructive detector and then to
the Electrospray (or APCI). In a parallel path configuration, the sample is split,
usually with a standard tee, with part of the flow going to each detector.

A serial configuration provides maximum sensitivity to the alternate detector
because it receives the full sample flow. It is also easier to do post-column addition
in this configuration. The disadvantages are that the detector must be
non-destructive and its flow cell must tolerate high pressures. Also, the flow cell can
cause peak broadening that will affect spectrometer data.

Parallel path

A parallel configuration eliminates peak broadening problems and makes sample
fraction collection easy. It also allows destructive detectors. Sensitivity is reduced
slightly for the alternate detector because it does not receive all of the sample. A
parallel configuration also complicates post-column additions and is prone to
split-ratio variations.

6.2.2 Using the Syringe Pump at LC Flow Rates 

The higher flow (LC compatible) configuration is very similar to the low flow
configuration as viewed from the syringe pump. The inclusion of the LC pump is easily
accomplished by simply adding a tee directly above the connection made to the
Electrospray nebulizer.

Typically the syringe pump is operated at flow rates from 1 µL/min (60 µL/h) to 10
µL/min (600 µL/h). The LC pump is typically operated from 100 µL/min to 1 mL/min. The
actual dilution is simply a ratio of the flow rates. Dividing the initial sample concentration
by the dilution factor gives the final concentration at the nebulizer.

Concentrations as low as 1 pg/µL (after dilution) can give good results in infusion
experiments. The factors that limit this sensitivity are background contamination that
may exist in the LC system, solvents, or sample.

When properly configured, the sample solution is metered into the LC flow stream.
Because the flow rates are higher, it is important that all connections are correct and
tight. Small leaks may dramatically effect the small infusion amounts coming from the
syringe pump.
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6.3 Nanospray

For analyzing sample with low concentration and volumes, the ESI source can be
configured with the Nanospray assembly in place of the standard Electrospray spray
chamber. The Nanospray operates at a flow rate of less than 20 nL/min by delivering the
analyte to the source via a small inner diameter needle positioned at the center of the
source.

For Nanospray, nebulizing gas is not used, and drying gas is applied at lower
temperatures than in Electrospray applications. High voltage is applied to the capillary
only.

There are two assemblies in use:

• The On-Axis Nanospray assembly (left in Figure 6-4) includes an XYZ stage
immediately in front of the spray chamber that accepts a needle assembly for
on-line or off-line Nanospray applications. The unit features a camera and LCD
screen for monitoring spray operation.

• The Off-Axis Nanospray assembly (right in Figure 6-4) delivers the analyte via an
off-axis needle assembly. The Off-axis Nanospray assembly includes a microscope
for monitoring.

Figure 6-4 On-Axis (left) and Off-Axis (right) Nanospray Assemblies
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6.3.1 Installing the Nanospray Assembly

This section describes how to install the On-axis Nanospray Assembly. For detailed
instructions, refer to Apollo On-Line NanoElectrospray Ion Source User Manual.

To replace the Electrospray with the On-axis Nanospray:

1. At the computer workstation, click Standby in the Instrument group to bring the
instrument from operation mode to standby mode.

The ESI voltages are turned off.

2. Double-check to ensure that the ESI voltages and the TOF voltages are off.

The light on the high voltage indicator on the ESI front panel must be off and the
Instrument HV unit is disabled (Enable LED is off).

3. Click the ESI Source tab and set the Dry Gas Temp to 30° C or below.

4. Uncheck Neb Gas and DG Heat in the Gas/Heater Control Group.

5. Disconnect the nebulizing gas from the Electrospray.

6. Release the latch on the left side of the spray chamber and swing the assembly out
so that the spray shield is visible (left in Figure 6-5).

7. After the spray chamber has cooled, remove the spray shield from the end plate and
capillary entrance (right in Figure 6-5).

Figure 6-5 Endplate with Spray Shield in Place (left)
and with Spray Shield Removed (right)
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8. Insert the gas diverter disk into the endplate (left in Figure 6-6), and place the
capillary cap over the capillary entrance (right in Figure 6-6).

Figure 6-6 Placement of the Gas Diverter (left) and Capillary Cap (right)

9. Lift the spray chamber door from the hinges on the ESI Source assembly.

10. Place the Nanospray assembly on the hinges, and close and latch the spray
chamber.

For Nanospray operations, high voltage is applied to the capillary only. After
installing the Nanospray assembly, you should use the Source Control Unit to set
Source Lens Current display to read the current on the Capillary.

11. Use the arrow buttons below the Source Control Panel LCD display to position the
display cursor on Cap (Figure 6-7).

Figure 6-7 Select Cap for the Source Lens Current Reading
6-12 Operator Manual, Version 1.0, Volume II: Operation



 6 Introducing Samples
6.3.2 On-Line Nanospray

For On-Line Nanospray use Nanospray needles such as 8 micron inner diameter or
15 micron inner diameter New Objective™ Tips.

To install the Nanospray needle for On-Line operation:

1. Use a union to connect the Nanospray needle and the transfer line as shown in
Figure 6-8 and either of the two needle configurations in Figure 6-9.

 

Figure 6-8 Installing the Needle for On-Line Nanospray

Peek ZDV Union

Syringe Fillport 1/16”

Upchurch Scientific
0.010” (P 742)

Valco (357VISF1)

Fingertight Fitting
Upchurch Scientific
(F 120) Large Bore Fitting

Upchurch Scientific
(F 294X)

Silica SealTight Sleeve
Upchurch Scientific
280  µm (blue, F 240x)

Silica SealTight Sleeve
Upchurch Scientific
380 µm (green, F 242x)

Flangeless Ferrule
Upchurch Scientific
(P 200Nx)

Fused Silica Capillary
LC-Packings
75  µm ID, 280  µm OD
(FS-75)
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Figure 6-9 Typical Needle Configurations

2. Place the assembly in the XYZ stage.

Note: Be careful not to bump the needle against the capillary cap.

3. Use the stage adjustments and the assembly optics to position the needle on axis
with the capillary with the tip about 2.0 mm from the opening in the capillary cap.

4. Connect the transfer line to the nanoLC system or a syringe.

5. Set the Capillary voltage to 600 V in the ESI Source tab.

6. Start the nanoLC system or syringe pump, and place the system in operation.

7. Increase the Capillary voltage in 50 V increments until the current is visible in the
Source Lens Current indicator.

8. Adjust the XYZ controls on the Nanospray assembly to optimize the spray.

9. In the BioTOF window, check DG Heat in the Gas/Heater Control group, and set the
Dry Gas Temp in the ESI Source tab to 50 °C.

10. At the Source Control panel, set the dry gas flow to one-quarter of the scale. 

11. Adjust dry gas flow and temperature to optimize for solvent conditions.

Stainless Steel ZDV Union
Upchurch Scientific
0.007” (U-411)
0.010” (U-435)

Silica SealTight Sleeve
Upchurch Scientific
280  µm (blue, F 240x)

Fused Silica Pico Tip
New Objective 
(FS360-50-15-D)

Silica SealTight Ferrule
Upchurch Scientific
(F 192x)

Fused Silica Capillary
LC-Packings
50  µm ID, 280  µm OD
(FS-50)

Fused Silica Capillary
LC-Packings
75  µm ID, 280  µm OD
(FS-75)

SealTight Ferrule
Uphurch Scientific
(F c192x)

Fused Silica Pico Tip
New Objective 
(FS360-50-15-D)

Teflon Tubing
LC-Packings
(TF-250/350)
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6.3.3 Off-Line Nanospray

For Off-Line Nanospray applications, use Pre-opened Nanospray needles such as
2 micron inner diameter or 4 micron inner diameter New Objective™ Tips.

For off line Nanospray:

1. Use a micro-pipetter fitted with a gel-loader tip to deliver 1 to 3 µL of analyte solution
through the larger diameter end of the tip into the Nanospray needle.

2. Shake down the assembly to allow the liquid to flow forward in the Nanospray tip.

3. Place the filled needle in the fitting and place the fitting in the XYZ stage.

4. Use the stage adjustments and the assembly optics to position the needle on axis
with the capillary with the tip about 2.0 mm from the opening in the capillary cap.

5. Set the Capillary voltage in the ESI Source tab to 600 V.

6. Place the system in Operation.

7. Increase the Capillary voltage in 50 V increments until the current is visible in the
Source Lens Current indicator.
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6.4 E-Z Nanospray

The E-Z Nanospray Ion Source allows you to set up an off-line Nanospray application
without removing the Electrospray spray chamber. An E-Z Nanospray assembly holding
a disposable needle with the analyte solution is inserted on axis into the front of the
spray chamber door (Figure 6-10).

Figure 6-10 E-Z Nanospray Assembly Installed in the Spray Chamber Door

E-Z Nanospray
Assembly
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6.4.1 Preparing the Nanospray Needle

Pre-opened Nanospray needles such as 2 micron inner diameter or 4 micron inner
diameter New Objective™ Tips, are suggested when using the E-Z Nanospray
assembly.

To prepare a Nanospray needle for use: 

1. Use a micro-pipetter fitted with a gel-loader tip to deliver 1 to 3 µL of analyte solution
through the larger diameter end of the tip into the Nanospray needle (Figure 6-11).

Figure 6-11 Preparing a Nanospray Needle

2. Slide the rear of the needle into the entrance of the collet and mount the collet onto
the needle shroud (Figure 6-11). 

3. Shake down the assembly to allow the liquid to flow forward in the Nanospray tip
(Figure 6-12).

Figure 6-12 Nanospray Assembly

Nanospray Needle

Needle ShroudFunnel

Main Nanospray Assembly Body Collet
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6.4.2 E-Z Nanospray Installation

To insert the E-Z Nanospray Assembly in the ESI Source:

1. Open the spray chamber door, remove the spray shield from the endplate so that
the Capillary is visible, and close the spray chamber door (Figure 6-13).

Figure 6-13 ESI Source with Spray Shield Removed

Capillary

Endplate with
Spray Shield

Removed
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 6 Introducing Samples
2. Remove the louvered plastic cover and the glass cover from the port on the front of
the spray chamber (Figure 6-14).

Figure 6-14 Port Covers Removed for E-Z Nanospray

Note: Do not insert the E-Z Nanospray assembly unless the spray chamber door 
is closed and the latch on the left side is fully engaged.

3. Insert the E-Z Nanospray assembly into the port and push the assembly until it can
go no further into the spray chamber.
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6.4.3 Nanospray Settings

For Nanospray, only the capillary element is raised to a high voltage. The magnitude of
the voltage for Nanospray is lower than that needed for Electrospray applications. For
best sensitivity, operate at the lowest possible voltage needed to maintain a stable
Electrospray signal.

To set the chamber voltages:

1. Use the arrow buttons below the Source Control Panel LCD display to position the
display cursor on Cap (Figure 6-15).

Figure 6-15 Select Cap for the Source Lens Current Reading

2. Set the capillary voltage to 600 V.

3. With the mass spectrometer in operating mode, slowly increase the capillary voltage
in 50 V increments until the current is registered on the capillary.

At this point, the voltage applied to the capillary affects the flow rate through the
needle.

Caution: As the magnitude of the high voltages for negative ESI tends to be lower 
than those optimal for positive ion mode, caution should be used when 
adjusting voltages to avoid arcing. Arcing can destroy the coating of the 
needle tip.

6
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6.5 Configuring the APCI Spray Chamber

This section describes how to convert the ESI Source assembly to use the APCI Source
(Figure 6-16).

Figure 6-16 Source Configured with the APCI Source

Note: Installation of the APCI source requires that you open the panels of the 
instrument. 

Before installing APCI:

• Exit the BioTOF acquisition software and then turn off all electronics modules with
the power switch labeled Electronics.
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6.5.1 Installation

To install the APCI chamber:

1. Remove the right front panel section.

2. Disconnect the ESI source high voltage connector (large black round plug) from the
cable plug coming from the source controller.

This connection is found inside the frame, by tracing the cable from the source body
down to the connector.

3. Disconnect the Nebulizer gas from the ESI spray chamber.

4. Remove the ESI spray chamber from the ESI source body.

5. Place APCI spray chamber on the source hinges and close the latch.

6. Connect the Nebulizer gas to the APCI sprayer.

7. Connect the ESI source high voltage cable to the outlet on the left side of the APCI
spray chamber.

8. Connect the high voltage cable from the APCI source to the above mentioned
HV outlet cable of the Source controller inside the cabinet.

These plugs are keyed.

9. Make sure the connector are seated and locked properly.

10. Connect the 6 pin APCI heater cable to the mating cable plug in the source
controller cable tree.

11. Install the APCI drain and connect it to the outside vent.

12. Close the panel.

13. Open the APCI spray chamber and pull the spray shield forward, approximately
1 mm from the backstop position.

14. If necessary, lock the position with the screw.
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6.5.2 APCI Parameters

1. Turn on the power by pressing the Electronics switch on the Main Control panel.

2. Restart the BioTOF software.

3. Make sure the instrument is in Standby mode and the voltages are off:

• The Voltage On button on the left side of the Source Control Unit is off.

• The green Enable LED on the Instrument HV Panel is off.

4. Set to positive ion mode if not already done.

5. Set the source mode to APCI and verify that the source controller mode switches
are set to APCI.

The Corona Needle voltage is automatically set to 500 V.

6. Set the Endplate and Capillary to -2500 and -3000 V, respectively.

The polarity is not displayed in the ESI Source tab, but can be seen on the source
controller display.

In APCI mode, the polarity of Capillary and Endplate are opposite of the polarity of
Corona Needle.

7. Turn on the nebulizer and the drying gas, and set the nebulizer pressure to 60 psi
on the Source Control unit.

8. Set dry gas flow to 10 units and dry gas temperature to 250 °C.

9. Connect solvent/sample flow of MeOH/H2O or CH3CN/H2O from the LC system or
syringe pump at 20 to 150 µL/min

10. With the liquid flowing, set APCI Heater to 400º C and allow it to warm up for
10 minutes.
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11. The vacuum side voltages should be set for normal operation

The recommended default values are:

12. Set the ampere meter range switch on the source controller to High.

13. On the Source Control Panel, select CNdl for the Source Lens Current reading. 

14. Increase the Corona needle voltage until a stable current appears on the current
meter of the source controller. 

Using the above values for End and Cap, this should be reached at +1200 V to
+1300 V. The current should be in the 10-6 A range. Move or turn the corona needle
to establish contact if no current is observed at 1400 V. 

15. Set mass range to 100 to 700 and start data acquisition. 

Observe the spectrum and tune the CNdl voltage to get a stable signal.

Note: Do not use excessively high differential voltages between CNdl on one 
side and Endplate/Capillary on the other side. Keep End to Cap differential 
at or below 500 V, since higher voltages can lead to source arcing.

16. Switch to Chromatography mode and verify the performance with (manual) sample
injections (e.g. Reserpine m/z 609, 5 µL injections, 0.5 µM, 1 µM, 2 µM, 4 µM series)

17. Lower the dry gas flow carefully to optimize and stabilize the signal, but not lower
than 5 units.

Capillary Exit 130 V

Skimmer 1 40 V

Skimmer 2 30 V

Offset 15 V

Trap 45 V

Lens 50 V

RF Amplitude 600 V
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7 Methods

In the BioTOF system, the method consists of the ESI Source and mass spectrometer
operational settings. When the system is started, it uses the Last Good Method, that is,
the setting in use when the system was shutdown. You can adjust these settings using
the option buttons and the parameter tabs below the Spectra Display window, as
described in this chapter.

Additionally, you can save the current settings to a file for use later on similar projects,
or restore settings after using variations on a setup.

The Current method is identified in the status group in the upper left of the BioTOF
window (Figure 7-1).

Figure 7-1 Current Method Identified in the System Status Group

This chapter describes how to adjust a method using the option buttons and parameter
tabs, and how to save and load methods.

Current method
at startup

Current method
after loading
method file
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7.1 Control Buttons

The Ionization and ion Polarity option buttons (Figure 7-2) to the left of the parameter
tabs set the basic parameters for method.

Figure 7-2 Ionization and Polarity Groups

To set basic operating parameters:

1. Click the Ionization button that is appropriate from the ESI source to be used:

• ESI for the standard Electrospray Ion source

• nESI if you are using the low flow-rate Nano Electrospray source

• APCI if you are using atmospheric pressure chemical ionization

2. Select either Positive or Negative for Ion Polarity. 

The appropriate voltages are applied to the ESI Source and Spectrometer. The ion
polarity can be set remotely if the three-position Polarity switch on the Instrument HV
Voltage Panel is in the middle position.
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7.2 Mode Tab

Use the Mode tab (Figure 7-3) to set the instrument mode, display units, and mass 
range.

Figure 7-3 Mode Tab

Instrument Modes

There are three instrumentation modes:

• MS Only (Mass spectrometry only)

• Chromatography - MS for when the sample is supplied from an LC system,
and you want to display a chromatogram and the mass spectra. The Spectra
display window is divided into two panes, the top one showing the spectra and
the lower one showing ion counts from the connected LC system.

• FIA-MS (Flow injection analysis and mass spectrometry) to specify a run time.
With this mode, you set up the run in the Chromatographic Setting group by
specifying the total run time in minutes and a wait time for the solvent to clear.

Data Display

The default data display horizontal scale is m/z. When Instrumentation Mode is set to
MS Only or FIA - MS, you can also specify Flight Time or Points. When Instrumentation
Mode is Chromatography - MS, the scale must be m/z.

Mass Range

The Mass Range group specifies in m/z in Dalton to be recorded, displayed and saved.
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Chromatographic Setting

When the Instrument mode is either Chromatography - MS or FIA - MS, you specify the
duration of the data acquisition by entering Total Run Time and Solvent Delay in
minutes. The Solvent Delay allows you to flush previous samples from the system
before the start of the run. Solvent Delay is not included in Total Run Time.

When the Instrument mode is Chromatography - MS, you set a mass spectra acquisition
rate in the Chromatographic Setting group. The rate is between 1 and 70 spectra per
minute.

7.2.1 External Start

Use the External Start group in the lower right corner to enable and configure the start of
spectra acquisition on a signal from an external device such as an LC system.

To configure the external Start:

1. Click the Configure button to open the Configuration dialog box (Figure 7-4).

The dialog box configures two input and two output signals by defining whether a
positive or negative signal activates the switch.

Figure 7-4 External Start Configuration Dialog Box
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2. Use In 1 as a System Ready signal from an external device, and In 2 for starting
spectra acquisition from the connected device.

System Ready is equivalent to clicking the Operation option button in the Instrument
group (Figure 7-2 on page 7-2), while receiving a Start input is equivalent to clicking
the Start button in the Command Buttons group on the left side of the BioTOF
window.

3. Enable Out 1 to send a ready signal to an external device when the BioTOF system
transitions to a ready state, and Out 2 to switch the connected system on when you
click the Start button in the BioTOF window.

4. Click Apply and close the dialog box to return to the Mode tab.

5. Click Enable in the External Start group.

To read the current signals from the external device:

• Choose Tools > Diagnostics > Spectrometer.

The current values from the device appear in the lower right section of the
Parameter Setting - Spectrometer dialog box. See “Diagnostics” on page 5-21

To manually trigger a signal to a connected device:

1. Choose Tools > Diagnostics > Spectrometer to open the Parameter Setting -
Spectrometer dialog box.

2. Click -External Out 1 to send the ready signal or External Out 2 to send the start
signal.
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7.3 Chromatogram Tab

Use the Chromatogram tab (Figure 7-5) to define mass ranges from the LC system.
These will appear in the Spectra Display window. When the Instrument mode is
Chromatography - MS, the Chromatography pane displays a trace for each mass range
specified in the tab. Those ranges always include TIC,MS (Total Ion Chromatogram,
Mass Spectrum).

The control buttons on the right side of the table enable definition of Extracted Ion
Chromatograms so you can focus on specific ranges. When you select a range in the
tab a color bar at the base of the mass spectrum pane identifies the ions as determined
by the mass spectrometer.

Figure 7-5 Chromatogram Tab

To define an Extracted Ion Chromatagram range:

1. Click the Mode tab and select Chromatography - MS in the Instrumentation Mode
group if the Chromatography pane is not already displayed.

The pane includes a trace from the TIC,MS range.

2. Click the Chromatogram tab to display the display the Chromatagram tab.
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3. Use the Type pull-down list to select Extracted Ion Chrom.

4. Click the Add button to the right of the list.

5. Change the low and high values in the Masses field by doing one of the following:.

• Type over the value on each side of the hyphen.

• Drag the cursor across a section of the TIC.MS trace in the Chromatography
pane. When you release the mouse button, the start and end values are
displayed in the Masses field.

6. Use the pull-down list in the Color field to select a color for the trace in the
Chromatography pane and the marker bar in the Mass Spectrometer pane.

7.4 Calibration Tab

The Calibration tab (Figure 7-6) provides access to reference tables so you can
calibrate the spectra displayed in the BioTOF window to the mass of a known
constituent in the sample. Use of this tab is described in detail in Chapter 9 “Calibration”.

Figure 7-6 Calibration Tab
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7.5 ESI Source Tab

The ESI Source tab (Figure 7-7) includes groups for setting gas flow, gas temperature,
and voltages applied to various ESI Source components.

The active settings on the tab depend on the button selected in the Ionization group
(see Figure 7-2 on page 7-2).

Figure 7-7 ESI Source Tab

Gas Flow/Temperature

When the Instrumentation is either ESI or nESI, Dry Gas Temp is the only active field in
the Gas Flow/Temperature group. For ESI and nESI Dry Gas Temp is typically set
between 200° C and 220° C.

When the Instrumentation is APCI, Dry Gas Temp and APCI Neb Temp are active. 
Typical settings are 250° C and 400° C, respectively.

Dry Gas Flow and Neb Gas Flow are not active in the BioTOF software, as these flow
rates are set with control on the Source Control Unit panel.
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High Voltage Electrodes (Volts)

When Instrumentation is ESI or nESI, high voltage is applied to three electrodes:

• Cylinder

• End Plate

• Capillary

When Instrumentation is APCI, high voltage is applied to:

• Corona Needle 

• End Plate

• Capillary

When Ion Polarity is Positive, the actual ESI spray chamber voltages in the High Voltage
Electrodes group are negative. 

Note: The software limits the difference between any two of the spray chamber 
voltages to a maximum of 2000 V. You may need to increase the 
voltages sequentially and in steps. 

Lens (Volts)

The voltages in the Lens group in Figure 7-7 are typical settings.

• The Offset must be 15 V.

Refresh button

• Click the Refresh button to send the displayed gas and voltage values to the ESI
controller.
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7.6 Spectrometer Tab

The High Voltage settings on the Spectrometer tab (Figure 7-8) are set during
installation and configuration of the system and should not be modified.

Note: Changing the parameters in the Spectrometer tab changes the mass 
calibration. These advanced parameters were set during installation and 
are specific to each instrument. Modifying these parameters can adversely 
affect system performance.

The BioTOF system must be re-calibrated if any of the Spectrometer tab values are
changed.

Figure 7-8 Spectrometer Tab
7-10 Operator Manual, Version 1.0, Volume II: Operation



 7 Methods
7.7 Timing Sequence Tab

The Timing Sequence tab is used to set the cycle delay time and duration used in the
mass spectrometer. The values shown in Figure 7-9 are the default values, which are
appropriate for most cases.

Figure 7-9 Timing Sequence Tab

Pulse ON/OFF

The Pulse ON/OFF button in the lower right corner of the Advanced Spectrometer
Timing group toggles operation of the HV pulser that supplies a high-voltage pulse to
the Repeller in the accelerator. This pulse changes the trajectory or the ion and sends
them into the TOF flight tube. The pulser must be on for the BioTOF to collect mass
spectra. However, when troubleshooting unexpected results, it may be useful to turn off
the pulser so that there are no ions travelling through the tube and reflected back to the
detector. The digitizer continues to send data to the BioTOF window allowing you to
identify data points that are not a result of detecting reflected ions.
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7.8 Acquisition Tab

The settings on the Acquisition tab (Figure 7-10) determine display and data recording
resolution.

Figure 7-10 Acquisition Tab

Acquisition Window

The m/z range is set on the Mode tab (Figure 7-3 on page 7-3). The m/z range and the
Spectrum Size set on this tab determine total size of a the spectra file.

The Spectrum Size is set in the number of data points per record. The maximum
number of data points per record is 252,000. The number of points determines the disk
space required for a single spectrum, as shown in kilobytes in the field to the right. 

The Digitizer Delay is specified in µs from the start of each data acquisition cycle until
the digitizer begins recording data. This delay establishes the low end of the m/z range.
When you change the delay, the mass range is shifted accordingly.

Sample Rate

There are three sampling rates: 0.5, 1.0 and 2.0 gigasamples per second. The higher
the rate, the greater the digitizer resolution, that is, the number of data points across the
ion peak. However, as you increase the sampling rate, the upper end of the m/z range is
decreased. If you increase resolution, you may need to adjust either Spectrum Size or
Digitizer Delay to capture the correct m/z range.
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Advanced Digitizer Setting

• Spectrum Offset adjusts the zero point of the vertical scale in the Spectra Display
window. Increasing the value excludes data points that may be noise. The offset
should be in the range -0.4 to 0.4.

• End of Scan Deadtime is a delay at the end of a cycle before the next cycle begins.
This value cannot be changed from the BioTOF window.

Advanced Data Handling

• Digitizer Summing sets the number of records the digitizer accumulates before it
sends the summed records to the BioTOF software as a single Spectrum. A setting
of 20 is usually appropriate.

7.9 Method Files

When the BioTOF window is opened, the application loads the Last Good Method, that
is, the system settings and parameters that were in use when the system was closed.
The Method menu allows you to save the current method to a file and load previously
saved methods.
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7.9.1 Save Method

Use the Save Method function to create a new method or to update a previously saved
method.

This menu function does not save mass spectrum data. Click  in the
Command Buttons pane on the left side of the window to store data for analysis.

To save the current method for later use:

1. Choose Method > Save As to open a Save As dialog box (Figure 7-11).

Figure 7-11 Save As Dialog Box for Saving a Method

The dialog box displays the methods that have been saved in ..\Data\Methods
folder; the files in the folder are filtered to include only those with the extension
*.tofpar. You can change the path, but you must use the *.tofpar extension.

2. Select an existing method in the dialog box to update file with the current
parameters, or enter an unused name to create a new method.

3. Click Save.

If you save to an existing name, a dialog box prompts you to confirm the action.

• Click Yes to overwrite the previous file or No to cancel the action and select a
new name.

The Current method field changes to the name of the saved file.

When you exit the BioTOF window, the system saves the parameters and presents
them as the Last Good Method next time the window is opened.
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7.9.2 Load Method

To load a previously saved method:

1. Choose Method > Load Method from the menu bar, or click ( ) in the tool bar.

An Open dialog box displays the methods that have been saved in ..\Data\Methods
folder (Figure 7-12). The files in the folder are filtered to include only those with the
extension *.tofpar.

Figure 7-12 Open Dialog Box for Loading a Method

2. If the method is stored in another location, use the dialog box tools to browse to the
other folder.
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3. Select the method and click Open.

The BioTOF system displays a progress gauge as it loads the method (Figure 7-13).
It can take several minutes for the data to be loaded. When finished, the method file
name is shown in the Current Method box on the left side of the BioTOF window.

Figure 7-13 Progress Gauge as a Method is Being Loaded
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8 Acquiring Data

After introducing the sample to the ESI Source and selecting the acquisition method, the
next step is to acquire and save spectra. Topics covered by this chapter include:

• Starting system operation

• Acquiring and saving spectra

• Acquiring spectra in MS - Chromatogram mode

• Multipass

8.1 Starting System Operation

To start BioTOF operation:

1. In the BioTOF window, click the Operation option button in the Instrument group
(Figure 8-1).

Figure 8-1 Instrument Control Group
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The instrument goes from Standby to Operation.

The Enable LED on the Instrument HV unit lights up (Figure 8-2) and the high
voltages ramp up. All ESI source voltages turn on.

You may also be prompted to press the Voltage On button on the Source Control
unit (Figure 8-2). This switch lights up to indicate that the source voltages have been
turned on.

Figure 8-2 Source Control Unit and Instrument HV Panel

2. Start the sample flow from the syringe pump or LC system.

Voltage On

LED indicates
high voltages
enabled.

Button
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3. If using the syringe pump, press and hold the two right buttons on the syringe pump
to fast-forward the solution to the ESI.

When sample is flowing through the tip of the spray needle assembly, and nebulizer
gas and spray chamber voltages are turned on, the current meter (Figure 8-3) of the
ESI source controller indicates the spray current.

If there is no reading:

• Check to make sure that the meter is set to read the endplate electrode, as
described in “Start the System” on page 4-1.

• Adjust the needle “Adjusting the Electrospray Needle” on page 6-4

• Verify that the spray shield is installed.

4. Release the two syringe pump buttons to stop fast forward, and press Run the pump
at the specified rate.

Figure 8-3 Source Lens Current Reading
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8.2 Acquiring and Saving Spectra

Controls and indicators for starting and stopping spectrum acquisition are located in the
two panes on the left side of the BioTOF window (Figure 8-4). You can start acquisition
when the status bar is green and displays Ready.

Figure 8-4 Indicators and Controls on the Left Side of the BioTOF Window

To run spectra acquisition:

1. Click the Start button. Data acquisition and transfer begin, and the Spectra Display
plots the results. The Spectrum Counter indicates the total number of records
accumulated in the buffer. The Start button changes to a Stop button, enabling you
to manually stop acquisition when a sufficient number of records have been stored
in the buffer.

You can start
acquisition when

the status bar
is green.

Shows the number
records stored
in the buffer.
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2. Click the two checkboxes in the lower left corner of the Spectra Display to enable
autoscaling for both axes of the display (Figure 8-5). The BioTOF continues to
accumulate records until the buffer contains the number of records specified in
PreSet Spectra.

• If Manual Stop is selected, the buffer is cleared and a new acquisition is started.

• If Auto Stop is selected, acquisition stops and the data in the buffer is
maintained.

Figure 8-5 Spectra Display

3. Click the Stop button to manually stop the acquisition when there sufficient records.
The Save button becomes active.
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4. Click Save in the control panel.

The BioTOF software opens a dialog box for setting the file options (Figure 8-6).

Figure 8-6 File Save Options Dialog Box

The BioTOF application creates two files, one formatted for the DataAnalysis
application, the other compatible with the XMass.

To set the application to use either or both formats:

• Choosing Format > DA  format and/or Format > Xmass format from the
menu bar.
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8.3 Multipass

Multipass is a patented technology available in Bruker’s BioTOF Series Time-of-Flight
mass spectrometers. Multipass effectively multiplies the length of the flight tube by
sending the ions through the tube multiple times creating a much longer instrument with
enhanced mass resolution.

Multipass is accomplished by keeping the Repeller voltage up when the ions return from
the Reflectron, thereby sending them back into the flight tube for another turn. After the
desired number of turns, the Repeller voltage is dropped and ions pass through the
Accelerator and on to the Detector. As ions move at different velocities through the flight
tube, the timing of the Repeller voltage depends on the mass range of interest. High and
low m/z ions may separate so far that they are no longer in the same cycle and the free
spectral range of ions with the same number of turns is limited as shown in Table 8-1.

Table 8-1 Spectral Range for Multiple Passes 

Passes Ratio of High m/z to Low m/z

2 4.4

3 2.3

4 1.9

5 1.6
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8.3.1 Using a Predefined Multipass Method

Multipass methods are saved on the BioTOF workstation during final test in the factory
and re-confirmed during installation. These methods are defined typically for a standard
mass range. To change the mass range in multipass mode, the digitizer acquisition
delay and the Repeller timing must be reconfigured as described below.

To set up multipass using a predefined method:

1. Click Standby in the Instrument group, load the predefined multipass method, and
then click Operation in the Instrument group.

2. Select the Mode tab and enter the low end of the desired mass range in the Mass
Range [m/z] group.

3. Calculate the high end of the new range using the ratios in Table 8-1 on page 8-7
and enter the value in the Mass Range [m/z] group.

4. Click the Acquisition tab and find the new Digitizer Delay in the Acquisition
Window group.

5. Click the Timing Sequence tab and set the set Repeller to 5 µs lower than the new
Digitizer Delay value.

6. Test the new settings with a standard sample. 

7. Fine-tune Multideflector High, Multideflector Low and Reflectron voltages, as
necessary.

8. Recalibrate the instrument.

9. Save the parameters as a new method.
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8.3.2 Creating a Multipass Method

The flight times multiply approximately with the number of turns in Multipass mode, that
is, for two passes flight times approximately double, for three passes they triple, and so
on. However, the focusing conditions change and it is necessary to retune the
Reflectron voltage in order to achieve best performance. In general, the Reflectron
voltage increases with the number of turns. Set up Multipass methods sequentially for
two, three or more passes. 

To set up multipass without a predefined method:

1. Start in normal mode (single pass, positive ions) using a strong sample with only
one or two well known peaks chosen in accordance with the Table 8-1 on page 8-7.

2. Click the Mode tab and select Flight Times in the Data Display group.

3. Note the flight times for the peaks of interest. 

4. Click the Acquisition tab and set the Digitizer Delay 5 to 10 µs below the doubled
flight time of the (low m/z) peak.

5. Change to the Timing Sequence tab and set the Repeller duration to 5 µs lower
than the new Digitizer Delay.

6. Record a spectrum.

Out-of-focus peaks will appear at approximately doubled flight times.

7. Retune the Reflectron, Reflectron Lens and multideflector voltages for optimized
performance, as described in “BioTOF Reflectron Tuning” on page 10-6. 

8. Click the Mode tab and select m/z in the Data Display group.

9. Record a spectrum and recalibrate the instrument (two passes).

10. Save spectrum and save the method with new parameters and new calibration.

11. Proceed to setting up a three-pass method accordingly. 
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8.3.3 Tips on Using Multipass

Tuning

Experience shows that the sensitivity of the Reflectron voltage tuning increases with the
number of passes as well as the importance of fine-steering of the ion beam provided by
Multideflector Low voltage.

Eliminating un-wanted ions from the mass spectrum:

In a complex sample, ions of m/z higher or lower than the accepted mass range may
appear in the spectrum after the wrong number of passes. Those ions are typically not
in focus, but may be of significant intensity particularly if their number of passes is lower
(that is they are higher m/z ions) than specified by the multipass method.

To eliminate higher m/z ions:

• Switch to the Timing Sequence tab and set Deflector off Delay to a low value 
such as 2 or 3 µs.

This setting turns off the steering voltage before high m/z ions have passed through
the multideflector into the flight tube. The trajectories of those ions are not be
corrected for the orthogonal drift, and the ions are effectively eliminated from the
spectrum.

Try this approach in single pass mode first and observe the affect on the mass range
transmission.

To eliminate lower m/z ions:

• Switch to the Timing Sequence tab and increase the Transfer delay.
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 9 Calibration
9 Calibration

As part of the BioTOF installation, the system was calibrated using a table of reference
masses included in the software. The Calibration tab enables you to check the
calibration after acquiring spectra from a known sample.

See “Time-of-Flight Calculation” on page 3-9 for any explanation of the calibration
formula.

9.1 Reference Tables for Calibration

The following tables are supplied with the BioTOF software:

Table 9-1 Reference Tables for Calibration

Reference File Description

Peptides.ref Positive ions, Peptides

Negative_Ions.ref Negative Ions Peptides, Assorted

NA-TFA_neg.ref Sodium-TFA (trifluoracetic acid), negative ions

NA-TFA_pos.ref Sodium-TFA, positive ions

PEG_Na.ref Sodiated Polyethylene Glycol, positive ions

HPESIPOS.ref Agilent ESI Tune mixture, positive ions
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The reference files are ASCII text file consisting of a two-column list of elements and
their masses. Figure 9-1 shows the file format.

Figure 9-1 Sample Reference File

The files are located in the ..\biotof\systems\list directory.
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9.2 Calibrating the System

To calibrate the BioTOF system:

1. Acquire spectra from a sample with known constituents.

2. Click the Calibration tab to display the table of reference masses.

3. Use the pull-down list at the top of the tab to select the reference file for display in
the Reference in the tab.

4. Select the first known sample used in acquiring the spectra (Angiotensin II in
Figure 9-2).

A red vertical line appears in the Spectra Display at the calculated position of the
selected compound on the m/z scale, and the cursor in the Spectrum Display
changes to the Max cursor ( ).

Figure 9-2 Calibrating the BioTOF System
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5. Drag the cursor immediately to the right of the mono-isotopic peak of the reference
compound and click the left mouse button.

The cursor snaps to the peak and the mass appears under the Current Mass in the
reference table in the Calibration tab.

6. Use the same technique to snap the line to the next peak, but keeping second
cursor below the top of the first peak.

A minimum of two peaks is required for linear calibration. If you add more than two
peaks, the software computes a least-squares fit. 

7. Click the Linear button in the Fit group to display the new calibration constants.

8. Check for obvious errors, such as negative constants.

These errors can occur if the peaks selected are not the proper compounds or the
max cursor snapped to the wrong mass.

To restart a calibration:

1. Click Clear in the bottom left corner of the tab to erase values in the Current Mass
column and clear the three constants in the Fit group.

2. Repeat steps 4 through 8.

3. Click the Accept button in the Fit group.

The new values appear in the Constants group to the right and the mass scale in the
Spectra Display changes accordingly.

To calibrate using a curved line:

• Snap at least three peaks and click Quadratic.

To temporarily add a reference mass to a table:

1. Enter a name in the field immediately to the right of the Add button.

2. Enter a mass in the next field.

3. Click Add.

The new reference mass is listed in the table. However, the mass is deleted when
you click Clear, select a new table, or exit the BioTOF software.

Note: The Preset button is a service tool that allows a rough calibration based 
mainly on instrument voltages. Use Preset if you do not have any 
calibration and need a starting point.
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9.3 Creating a Custom Reference File

You can set up a custom reference file by copying one of the reference files and adding
reference masses for items of interest.

To create a new file:

1. Use Notepad or a similar text editor to open one of the supplied reference files.

2. Choose File > Save As from the menu bar and save the file in the same directory
with a different name and the extension .ref.

Note: Do not include any spaces in the file name.

3. Delete any line that you do not want in the reference table, but keep at least one line
to use as a template.

4. For each new constituent, add a line consisting of the name and the reference mass,
aligning the references masses on the decimal.

5. Follow these rules:

• Use the space bar, not Tab, to insert spaces between the name and the
reference mass value. 

• Use the underscore character instead of spaces in the compound names.

• Do not press Enter immediately after the last reference mass.
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10 Maintenance

This chapter covers routine maintenance, and basic and advanced troubleshooting.

10.1 Daily Maintenance 

Daily cleaning of the ESI Source is necessary to maintain optimum performance and
sensitivity for the BioTOF system.

To clean the ESI Source:

1. Click Standby in Instrument group to turn off the high voltage.

2. Turn off Dry Gas Heat and allow the system to cool.

3. Flush the transfer line from the syringe pump or LC system.

Generally, you can flush the line with the solvent last used in operating the source. It
is recommended to flush with a volume of at least 1 to 2 mL of solvent. 

4. Open the spray chamber and wipe it with a methanol-soaked tissue.

5. Remove the spray shield and wipe it clean with a methanol-soaked tissue.

6. Wipe the capillary entrance with a methanol-soaked tissue and reinstall the spray
shield.

7. If the project has included high flow rate applications, empty the high flow rate
bucket behind the system and follow approved procedures for disposing the LC
solvents.
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10.2 Monthly Maintenance

This section describes maintenance that should be performed on a monthly basis. You
may adjust the frequency of this routine maintenance depending on usage and sample
concentrations. Monthly maintenance of the BioTOF system includes:

• The cleaning specified in daily maintenance

• Checking the oil level in the vacuum pump

• Cleaning the Capillary and Skimmer 1 in the ESI Source

The last task required that you shut down the vacuum pumps.

10.2.1 Stopping the Vacuum System

The BioTof system is normally left running in Standby mode when it is not in use so that
the ESI Source and TOF Spectrometer pressure can be maintained below thresholds.

To shut down the vacuum system:

1. At the control station, stop data acquisition and bring the BioTOF system into
Standby mode if you have not already done so.

Standby Mode turns off the ESI source and spectrometer voltages.

2. Check the Enable light on the High Voltage unit and the light in the ESI High
Voltage switch to ensure that the voltages are in fact off.

Use the manual switches on the Instrument HV panel and the Source Control Unit.

3. When both lights are off, allow the source to cool down and seal the inlet of the
capillary.

4. Select gauge 1 on the gauge controller and press ON/OFF.

Note: It is recommended (but not required) that you turn off all electronics by 
pressing the ELECTRONICS switch on the main switch panel. This may 
also require shutdown of the BioTOF software and a restart the next time 
the system is turned on.

5. Release VACUUM PUMPS switch on the main switch panel.

As soon as the Turbo Pumps have slowed sufficiently, the vacuum system
automatically vents with air filtered through an air dryer cartridge.

6. Allow approximately 10 to 15 minutes for the vacuum pump to spin down and for the
system to vent to atmosphere completely. 
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10.2.2 Cleaning the Capillary and Skimmer 1

To clean the Capillary:

1. Raise the hood on the ESI source and use a screwdriver to loosen the two holding
screws on the left side of the source housing and swing the housing open (See
Figure 5). 

Figure 10-1 Skimmer 1 and Capillary Exit in the ESI Source

2. Open the spray chamber door and remove the end-cap that covers the face of the
glass capillary.

The glass capillary is removed from the source by unscrewing the knurled nut that is
behind the capillary exit and pulling the capillary out from the front (spray chamber
side). 

Note: Pull the capillary straight out until it is completely removed from the 
assembly.

3. Once removed, flush the capillary with an appropriate electrospray solvent.

Wiping with a lint-free cloth, Kim-Wipe™ or similar, moistened with solvent will
sufficiently clean the metal-coated ends of the glass capillary.

4. Reinstall the Capillary, reverse the procedure above. 

Cleaning Skimmer 1 does not require removing it from the source.

Skimmer 1

Capillary Exit

Holding Screws
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To clean Skimmer 1:

1. Moisten a lint-free cloth with solvent and gently polish the exposed face of the
Skimmer. 

Depending on the amount of material deposited on the skimmer, it may be
necessary to perform this step a few times. The round metal shroud in which the
capillary exit resides should also be cleaned in a similar fashion. 

2. Inspect the skimmer and remove any fibers left from the cleaning.

3. Close the hinged door and tighten the two housing screws. The source is now ready
to be pumped down and turned on for operation. 
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10.2.3 Checking the Oil Supply

At least monthly, check the oil supply for the vacuum pump. The pump is located in the
right rear of the BioTOF system. The gauge is on the front of the pump.

To check the oil:

1. Open the door in the lower right corner of the right side of the cabinet to access the
pump motor (Figure 10-2).

Figure 10-2 Vacuum Pump Motor and Oil Gauge

2. Follow the instructions on the tag attached to the pump.

3. If a refill is indicated, contact Bruker Daltonics customer service for assistance and
to ensure that you have the correct oil.

Note: Use only the specified oil.

Gauge

Instruction
Tag
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10.3 BioTOF Reflectron Tuning

This procedure describes tuning of the BioTOF time-of-flight analyzer for resolution and
peak sensitivity. This procedure is completed during final test and reproduced during
installation and acceptance, and method files with the default parameters are stored on
the BioTOF workstation. Furthermore, the components of the BioTOF time-of-flight
analyzer are configured and mechanically aligned in the factory, or at installation by a
trained field service engineer. Once set, the tuning of the BioTOF system is stable and
does not require user interaction. The procedure is described here for reference and for
the purpose of retuning the instrument after extensive periods of use or shutdown of the
instrument.

Note: Before re-tuning the instrument, save the current parameters and 
calibration in a method file. Changing any of the TOF voltages will 
affect the instrument calibration and re-calibration is required after 
the instrument tuning.

10.3.1 Setup for Tuning

To set up the BioTOF system to tune Reflectron voltages:

1. Save the current parameters and calibration to a method file as described in
“Method Files” on page 7-13.

2. Click Operation in Instrument Group and Positive in the ion Polarity group, and
infuse a standard sample from the syringe pump.

3. Select the ESI Source tab to verify that the Offset in the Lens group is set to 15 V,
and that standard values are set for all other source parameters.

4. Select the Spectrometer tab and set the Detector to 1600 V.

Post Acceleration may be set to 2000 V but is not required at this point.

5. Use the Acquisition tab to verify that the Digitizer offset is set properly to give only
a 1-2 count electronic noise band per scan and set the Sample Rate to 1 Gsa.
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6. Set the voltages in the Spectrometer tab as follows:

7. Start data acquisition.

The instrument should show good ion signal of at least 1000 counts for 200 spectra
at the expected flight times (Leucine Enkephaline or Reserpine around 70 us).

With good signal proceed as described below; otherwise, enter the troubleshooting
procedure.

• If the ion signal is not strong enough, set Reflectron Lens to 500 V, and then
to 700 V.

• If signal is better with the higher Reflectron Lens voltage, proceed.

Note: Make sure that the spray and the spray current are stable. Check spray 
regularly during the tuning procedure

8. Pre-tune Multideflector High voltage in steps of 2 V up and down from the default
value for maximum signal intensity.

Repeller: 8500 V

Multideflector High: 67 V (BioTOF II) or the default value

Multideflector Low: 5 V (that is, no secondary deflection)

Reflectron Lens: 300 V

Reflectron: 9100 V
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10.3.2 Reflectron Tuning Procedure

The goal of the Reflectron tuning procedure is to optimize the Reflectron voltage for
mass resolution and simultaneously balance Multideflector High and Reflectron Lens
voltages for peak intensity.

Note: Do not change Repeller voltage during the tuning; leave it set at 8500 V.

1. Tune the Reflectron voltage as follows:

• Acquire a decent spectrum. Typically 200 to 500 scans should be sufficient with
standard sample.

• Set data acquisition to AutoStop with acquisition counter preset to an appropriate
number.

• Acquire a spectrum and DO NOT CLEAR.

• Set Reflectron voltage in steps of 100 V higher and lower from the starting value
covering the range from 8600 to 9600 V. This procedure generates an envelope
of peaks, with each peak (or group of isotope peaks) representing a Reflectron
tuning voltage.

• Settle for the voltage that gives the highest intensity in that envelope, which
coincides with the narrowest peak shape, squeezing all the ions into a narrower
package on the detector.

• Click the Clear button.

2. Optimize peak intensity by tuning the Multideflector High deflector voltage for
highest intensity initially in steps of 2 V, note the peak intensity, and then click the
Clear button.

For the BioTOF II, the Maximum intensity should be achieved somewhere between
63 and 72 V.

3. Change the Multideflector High to optimal voltage and acquire a new spectrum.
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4. Optimize peak intensity by tuning Reflectron Lens voltage in steps of 100V, noting
the peak intensity, then clear; change the voltage and restart acquisition.

Check peak shapes for splits, bumps or other irregularities. For good signal to noise
ratio always check intensities, resolution and peak shapes on the most intense peak
of the isotope distribution.

5. Go back to step 1 and repeat procedure, starting from the Reflectron voltage
determined in the first round. 

6. Zoom in on the most intense peak, turn on the data point markers, and check
resolution by estimating the (fractional) number of data points across the width of the
peak at half height.

At the 1 Gsa sampling rate, the time between data points is 1ns. Mass resolution is
equal to the flight time divided by 2 times the peak width in the same time units.

For example, at a flight time of 70 us or 70,000 ns, a peak width of 3.5 ns or 3.5 data
points corresponds to a mass resolution of 10,000.

At this point in the tuning resolution should be at least 8,500 to 9,000 or
approximately 4 data points for the Reserpine or Leucine Enkephalin peaks.

7. Save a spectrum and check resolution with the data processing software.

8. Start again with the voltage from the maximum peak, again not clearing the
spectrum between acquisitions.

9. Tune in steps of 50 V up and down, over a range of -150 V to +150 V from previous
optimum.

10. Follow the envelope of the tuning peaks and pick a voltage which correspond to the
visual maximum of the envelope. This may be in between the recorded steps.

11. Clear and fine tune Multideflector High in 1 V steps as described above, optimizing
peak shapes and resolution without giving up intensity by more than 10%

12. Fine-tune Reflectron Lens in steps of 50 V, optimizing peak shapes and resolution
without giving up intensity by more than 10%, then repeat from step 8.
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13. Clear and fine tune Reflectron voltage in steps of 25 V from previous best value.

Figure 10-3 shows a Spectra Display with 1000 spectra each for seven different
Reflectron voltages. The maximum at 9350 V corresponds to the best tuning
conditions.

Figure 10-3 Determining Reflectron Voltage Providing Maximum Resolution

14. Re-calibrate the instrument as described in Chapter 9 “Calibration”.

15. Save spectrum and save parameters and calibration in a new method file.
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10.4 Basic Troubleshooting

Figure 10.4 describes an algorithm for basic troubleshooting of the ESI Source. The
flowchart is meant for new users of the source and provides a simple, step-wise guide
based on observations of key parameters.

Figure 10-4 ESI Source Troubleshooting Flowchart 

Check the transfer 
line and spray needle

Clogged or Leaking?

No Signal

Check if the HV Indicator is ON 
(Green LED on Source Control)

Source Control LCD: Move the cursor to End or Cap, 
push the syringe and watch the spray current.

Check sample concentration 
and solvent conditions

Check the 
spray voltage

Set the voltages to 
typical values

Check lens voltages and 
instrument settings

Check RF box and 
connections

No Spray current
Spray current OK,

Check the 
sample flow

Still no current? 
Call Service

No

Yes

Too low

OK

No liquid flow

Turn on the HV and 
push the Voltage On 
button.

Check drying gas and 
gas needle

through sprayer
Clean capillary entrance

Check pressures

but no signal 
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10.5 Advanced Troubleshooting

A more extensive guide to troubleshooting is presented in Table 10-1. Diagnostics and
solutions to may of the problems depicted in these tables may require electrical tests or
cleaning of the source.

Table 10-1 Advanced Troubleshooting Table

Symptom Diagnostic Possible Cause Solution

Unstable signal 
and current

• Unstable signal

• Unstable current

Air bubbles Purge the solvent.

• Liquid droplet on 
the Endcap

Drying gas flow, 
temperature and 
nebulizing gas not 
optimized

Adjust drying gas, 
nebulizing gas, and 
temperature.

Poor sensitivity 
or weak signal

• Weak signal for 
standard

Source out of tune Tune the Source.

• Unusual settings 
needed for Cap 
Exit or Skimmers

Skimmer may 
be dirty

Clean the Skimmer.

• Low signal 
intensity through 
the entire range of 
voltage settings of 
Cap Exit

Bad electrical 
contact or bad cable

Check the continuity 
of the Capillary Exit 
spring contact inside 
the 45° door and cable

• Low signal 
intensity through 
the entire range of 
voltage setting on 
Skimmer 1

Bad electrical 
contact or bad cable

Check the continuity 
between pin 6 of the 
6-pin feedthrough and 
the first skimmer.

Dirty Capillary or 
Endcap

Clean the Capillary 
and Endcap.
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Error 151 • Check the 
Spray Chamber

Spray Chamber is 
not closed properly

Close the 
Spray Chamber.

• Check the 
HV cable

HV cable is not 
plugged in or has 
a defect

Plug in or change 
the cable.

Error 120 • Check RF box 
and cable

RF box and cable 
not connected 
properly

Fix the connection.

• Check the 
RF feedthrough, 
it is a short circuit 
to ground or to 
each other

Damaged hexapole Call for service.

• RF amplitude is 
above a certain 
value

Defective capacitor Call for service.

• None of the above Defective RF driver Replace the RF driver.

Error 122 - 
No heat from 
drying gas

• Check heater and 
TC cable

Loose cable Tighten the cable.

• Check the 
resistance of the 
heater. Should 
be 6 E0.5

• Check the 
heater fuse

Blown fuse Replace the fuse.

• If the Temperature 
setting is over 
300 °C

Heater has 
insufficient power

Lower the setting 
temperature or apply 
an extra 24 V/100 W 
power supply on the 
second heater.

Table 10-1 Advanced Troubleshooting Table (Continued)

Symptom Diagnostic Possible Cause Solution
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Table 10-2 provides the test points and values for all high voltage and low voltage
elements to the source. When performing an electrical test, use the software to set the
voltage of the element to a typical value listed in Table 10-2. The voltage interlock to the
source must be [Active]. The [Active] state indicates that the high voltage button to the
API 100/1600 is [On] and the spray chamber door is close.

Table 10-2 Electrode Test Points and Typical Values

Electrode Pin and Connector Pin to Element 
Resistance Typical Voltage

Capillary Pin 3 of HV Connector < 5 Ohms DC 3 kV ~  5 kV *

Endcap Pin 2 of HV Connector < 5 Ohms DC 3 kV  ~ 5 kV * 

Capillary Exit Pin 1 of lens Connector < 5 Ohms DC 50 V ~ 200 V *

Skimmer 1 Pin 6 of lens Connector < 5 Ohms DC 10 V ~ 20 V

Skimmer 2 Pin 2 of lens Connector < 5 Ohms DC 5 V ~ 10 V

Trap/(Extract) BNC (SMA) < 5 Ohms Pulsed 0 ~ 50 V

Lens (BioTOF) only Pin 4of lens Connector < 5 Ohms 10 V ~ 40 V

*Extreme caution should be used when measuring these voltages. Interlock must be 
defeated for measuring high voltages. Set all high voltages to <700 V before 
measuring.
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